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ABSTRACT 
This document describes in detail the LinguaCuisine Certification System v1.0, which based on DIGCOMP 2.1. 
The system is composed of a Framework that maps Competence Areas/Competences to digital and 
LinguaCuisine-specific skills and describes how questions and answers for the two certification tests are derived. 
It also contains a grading system for mapping the points gathered from the test to a DIGCOMP certification level. 
Complete tests (total 72 questions) are presented in the Annexes. 
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1. INTRODUCTION  

1.1 Context 

The LinguaCuisine project is about equality of access and participation in learning, focusing on digital and 
language skills. It promotes learning of digital literacy, languages, cuisines and cultures. It does this through co-
design of downloadable apps and social recipes, using an authoring tool to develop an online community of 
practice. We are aiming for widespread adoption of these learning materials with a focus on social inclusion. 

The development of a certification system for Digital Competences which participants develop, is one of the key 
objectives of the project. The needs addressed are: improving basic skills, specifically digital Competence, and 
engaging digitally marginalized groups (including refugees and migrants) with technology; certifying and 
assessing levels of digital Competence; learning foreign languages, cultures and cuisines. 

The LinguaCuisine Certification System v. 1.0 (LCCS) outlines the rules, procedures and management for carrying 
out a certification of a specific subset of competencies of the DIGICOMP 2.1 framework. It establishes specific 
requirements for the process used, tools of assessment, grading and certificate awarding procedures.  

The current version of the LCCS certifies digital and LinguaCuisine-specific skills derived from the following 
subset of DIGCOMP 2.1 set of Competence Areas: 

          Competence area 1: Information and data literacy 

1.1 Browsing, searching, filtering data, information and digital content 

1.2 Evaluating data, information and digital content 

1.3 Managing data, information and digital content 

Competence area 2: Communication and collaboration 

2.1 Interacting through digital technologies 

2.3 Engaging in citizenship through digital technologies 

Competence area 3: Digital content creation 

3.1 Developing digital content 

The LinguaCuisine-specific skills have been designed so as to support the process of learning foreign languages, 
cultures and cuisines by the trainees. They are purely digital skills related both to the process of learning through 
the cooking sessions organized by the project and through the use of the LinguaCuisine application (the Recipe 
Builder1). 

A significant part of the LCCS is the Framework that maps the skills to competences and to Proficiency Levels 
(PL). It is also used to derive appropriate certification questions that cover all basic skills at all levels. Scoring 
functionality is used to calculate the score of the certification and assign a trainee to a PL for each Competence 
under examination. 

The system uses two tests to award a PL certificate to a trainee. The PL is calculated for each Competence 
independently based on the results of both tests. For each Competence, the set of skills that corresponds to the 
PL certified, is awarded. Different PLs may be certified for different competences.  

                                                           

1 https://linguacuisine.com:8000/ 
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The certification system uses the newest version of DIGCOMP, version 2.1. This version is a significant 
improvement over version 1: 

• Dimension 1 (the Competence Areas) and Dimension 2 (the descriptors and titles) were updated, 

• the initial three PLs were replaced by eight levels offering more detail and precision. 

The two versions are fully compatible. 

1.2 The DIGCOMP v.2.1 framework 

Version 2.1 of the Digital Competence Framework for Citizens2 published by the European Commission in 2017, 
aims to provide evidence-based scientific support to the European policymaking process and has become a 
reference for the development and strategic planning of digital Competence initiatives. It has 5 dimensions: 

Dimension 1: Competence Areas (CA) identified to be part of digital Competence. They include: 

1) CA1: Information and data literacy: To articulate information needs, to locate and retrieve digital data, 
information and content. To judge the relevance of the source and its content. To store, manage, and 
organise digital data, information and content. 

2) CA2: Communication and collaboration: To interact, communicate and collaborate through digital 
technologies while being aware of cultural and generational diversity. To participate in society through 
public and private digital services and participatory citizenship. To manage one’s digital identity and 
reputation. 

3) CA3: Digital content creation: To create and edit digital content To improve and integrate information 
and content into an existing body of knowledge while understanding how copyright and licences are to 
be applied. To know how to give understandable instructions for a computer system. 

4) CA4: Safety: To protect devices, content, personal data and privacy in digital environments. To protect 
physical and psychological health, and to be aware of digital technologies for social well-being and social 
inclusion. To be aware of the environmental impact of digital technologies and their use. 

5) CA5: Problem solving: To identify needs and problems, and to resolve conceptual problems and problem 
situations 

Dimension 2: Competence descriptors and titles that are pertinent to each area  

Dimension 3: Proficiency levels for each Competence 

Eight Proficiency Levels for each Competence have been defined through learning out comes (using 
action verbs, following Bloom’s taxonomy) and inspired by the structure and vocabulary of the European 
Qualification Framework (EQF): 
1) Level 1: Foundation- Simple Tasks performed with help 
2) Level 2: Foundation- Simple Tasks performed with autonomy and guidance when necessary 
3) Level 3: Intermediate- Well defined, routine tasks 
4) Level 4: Intermediate- Well defined, non-routine tasks 
5) Level 5: Advanced- Different tasks and problems 
6) Level 6: Advanced- Most appropriate tasks 
7) Level 7: Highly Specialised: Complex problems 
8) Level 8: Highly Specialised: Complex problems with many interacting factors 

Each level description contains knowledge, skills and attitudes, described in one single descriptor for each level 
of each Competence; this equals to 168 descriptors (8 x 21 learning outcomes). 

                                                           

2 https://publications.europa.eu/en/publication-detail/-/publication/3c5e7879-308f-11e7-9412-01aa75ed71a1/language-en  

https://publications.europa.eu/en/publication-detail/-/publication/3c5e7879-308f-11e7-9412-01aa75ed71a1/language-en
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Dimension 4: Knowledge, skills and attitudes applicable to each Competence  

Dimension 5: Examples of use, on the applicability of the Competence to different purposes  

1.3 Structure of the Certification System 

The Certification System is comprised of the following parts: 

1. LinguaCuisine Conceptualization Framework (LCCF). The framework uses the 5 dimensions of DIGCOMP 
v2.1 and a subset of Competence Areas to provide a mapping between: 

• The competences and the generic digital skills 

• Generic digital skills and LinguaCuisine-specific examples of use (from which LinguaCuisine-
specific skills are derived) 

• Competences-skills and questions/answers for the two tests used for certification. 

The framework is extendable since more Competence Areas and Competences can be added and therefore the 
appropriate generic skills can be derived and mapped to them. The context can also be changed and Examples of 
Use can be designed to fit new requirements. 

The LCCF is presented in Chapter 2. 

2. Certification Tools: the certification tools include two tests of different type, Test I and Test II. They are 
designed to assess the PL of a Trainee both by way of a certification test (Test I- a multiple choose quiz 
of 41 questions) and by observation and rating by a tutor (Test II- observation sheet including 31 
assessment tasks). Each test calculates a score for each Competence and based on a predefined range of 
values, the score is mapped to a PL. Both tests use the same scoring method and they are designed to 
complement each other. The mapping of questions and answers of the tools to specific skills are 
presented in Chapter 3. The application of the LCCF in the project domain has produced two tests that 
are presented in Appendixes I and II (for Test I and Test II respectively). 

3. Grading Methodology: it provides the scoring ranges and algorithms for calculating the total score for 
each Competence assessed by the certification tools. The methodology meets the needs for 
compatibility between the two certification tools and for accurate results.  

4. Certificate Skills award. The Certification System awards certificates based on the Proficiency Level that 
was calculated for each Competence. Thus, each time a trainee is certified for a Competence, a specific 
set of generic and LinguaCuisine-specific skills award is produced. The list of these skills in relation to the 
Competence Area/Competence and Proficiency Level is presented in Appendix III. 

1.4 Application of the Certification System 

The certification system has been designed so that it can be applied to assess LinguaCuisine trainees. However, 
the framework used to map Competences to general skills can be used to extract examples of use that will, in 
turn, produce tests that are appropriate for a variety of scenarios. In this Certification System, questions 
addressed to the trainees are multiple-choice questions with several correct and some wrong answers. Correct 
answers are mapped to PLs and receive a score that depicts how advanced the level is (i.e. higher levels receive 
higher scores than lower levels). This kind of approach requires the design of questions with answers 
corresponding to all levels, an approach already followed by other DIGCOMP related projects3,4 as mentioned 

                                                           

3 ABC DIGITALE: SELF-ASSESSMENT TEST AND DIGITAL LEARNING OPPORTUNITIES 
4 ELENE4WORK SELF-ASSESSMENT TOOL FOR DIGITAL SOFT SKILLS IDENTIFICATION 
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in the JRC DIGCOMP into Action Guide5 (May 2018). The LCCF can be applied by designing questions that are 
Proficiency Level specific, that is they assess a specific level only. The advantages and disadvantages of these 
methods are discussed in Chapter 3. 

  

                                                           

5 https://ec.europa.eu/jrc/en/publication/eur-scientific-and-technical-research-reports/digcomp-action-get-inspired-make-it-happen-user-guide-

european-digital-Competence-framework  

https://ec.europa.eu/jrc/en/publication/eur-scientific-and-technical-research-reports/digcomp-action-get-inspired-make-it-happen-user-guide-european-digital-competence-framework
https://ec.europa.eu/jrc/en/publication/eur-scientific-and-technical-research-reports/digcomp-action-get-inspired-make-it-happen-user-guide-european-digital-competence-framework
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2. THE CERTIFICATION FRAMEWORK  

2.1 Introduction 

The LinguaCuisine Conceptualization Framework (LCCF) identifies the skills involved in the LinguaCuisine 
certification system. It provides a mapping of the skills to Competences (dimension 2 of DIGCOMP) and to 
Proficiency  Levels (dimension 3 of DIGCOMP). 

2.2 Framework Dimensions 

DIGCOMP 2.1 is used as a basis for designing this framework and as such, it follows the same structure.   

2.2.1 Dimension 1: Competence Areas 

This dimension uses 3 out of 5 Competence areas described in DIGCOMP 2.1, namely: 

• Competence area 1: information and data literacy 

• Competence area 2: communication and collaboration 

• Competence area 3: digital content creation 

2.2.2 Dimension 2: Competencies 

This dimension uses 6 out of 13 DIGCOMP 2.1 Competence descriptors for the 3 Competence Areas covered, 
namely: 

         Competence Area 1: Information and data literacy 

1.1 Browsing, searching, filtering data, information and digital content 

1.2 Evaluating data, information and digital content 

1.3 Managing data, information and digital content 

Competence Area 2: Communication and collaboration 

2.1 Interacting through digital technologies 

2.3 Engaging in citizenship through digital technologies 

Competence Area 3: Digital content creation 

3.1 Developing digital content 

There is a partial use of descriptors from Competence Areas 2 and 3. 

2.2.3 Dimension 3: Proficiency Levels 

Four (4) out of the eight (8) proficiency levels of DIGCOMP 2.1 are used in the LCCF, namely: 

Foundation level, including: 

Level 1: Basic level with guidance 

Level 2: Basic level with autonomy 

Intermediate level, including: 
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Level 3: Well defined, routine tasks 

Level 4: Tasks, well defined and non-routine problems 

2.2.4 Dimension 4: Knowledge, skills and attitudes applicable to each Competence  

This dimension includes LinguaCuisine –specific skills that are based on DIGCOMP 2.1 but are more targeted to 
the project’s scope; they are described in section 2.4. 

2.2.5 Dimension 5: Examples of use 

Examples of use are LinguaCuisine –specific and are described in section 2.4. 

2.3 The mapping dimensions to dimensions methodology 

The design of the certification tools requires in turn the design of questions that assess the skills of every 
Competence Area and Competence included in the LCCF. Digital skills can be either generic or related to the use 
of LinguaCuisine applications or methods. Both categories of skills need to be mapped to the specific 
competences of DIGCOMP. There is a one to many (1-N) relationship between a Competence and skills. 

Moreover, skills are Proficiency Level – specific, that is, a skill is mapped not only to a Competence but also to a 
specific Proficiency Level as well. These skills are called PL-Skills (Proficiency Level Skills). PL-Skills are the generic 
digital skills which the trainees of LinguaCuisine are going to acquire during the programme.  

Examples of use are presented for the certification of the Linguacuisine skills. They are derived based on skills 
and are LinguaCuisine specific. There is generally a many to one (N-1) relationship between skills and examples 
of use. From the examples of use, LinguaCuisine-specific skills are derived, these are also included in the skills 
which LinguaCuisine trainees are intended to acquire during the programme. Generic and LinguaCuisine specific 
Skills are complementary. They are presented in detail in Appendix III. The Examples of use, along with the PL-
Skills are used to derive questions and answers for the certification tools. The skills are described using the 
specific terms of each Competence and PL, having in mind the goals of each Competence. Terms such as 
“identify”, “find”, “explain” and others that appear in the descriptors of a Competence in DIGCOMP 2.1 are used 
to describe the skills and then to derive the examples of use. 

Skills are different at each Proficiency Level of each Competence. The descriptors provided by DIGCOMP are  
quite general and they permit design flexibility. However this also means a lack in practicality. The LCCF design 
differentiates the skills between each PL of a Competence in as most clear way as possible. The differentiation of 
skills between levels 1 and 2 (Foundation level) is based largely on the assistance a trainee needs to perform a 
task. This is directly and clearly incorporated into the examples of use and the answers that correspond to PL 1 
vs. the one that corresponds to PL 2 of a question that assess the knowledge of the skill. 

Questions need to be designed so as to uniformly assess each Competence covering as many PL-Skills as possible 
and all the LinguaSpecific skills. Answers to Test-I (multiple choice quiz for the trainee) are designed so as to rate 
multiple Proficiency Levels using the same question. Thus, questions of Test I are multi-levelled. This requires 
not only a micro- but also a macro-management of each Competence. Answers need to cover all PLs (micro-
management related to skills) while questions need to cover groups of skills that are relative to each other and 
they are also multi-levelled (they correspond to different PLs). These skills are called HL-skills and their goal is to 
help design questions that correspond to different PLs. This is needed because answers to each question do 
cover all PLs.  

HL-skills are internal to the design process of the LCCF. Questions conceptually group the assessment of skills 
from different PLs based on the semantic resemblance of the descriptors that correspond to each PL. Grouping 
is performed at a Competence level only. Semantic resemblance is expressed in the descriptors when the same 
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clause is used for performing tasks and the only difference is the type of the action, e.g. ‘identify’ for PLs 1 and, 
‘explain’ for PL 3 and ‘illustrate’ for PL 4. This mapping is presented in detail in section 3.3. 

The process of mapping dimensions to each other, requires the analysis of each Competence Area into 
Competences. This is provided by DIGCOMP 2.1. The next step is to process each Competence separately as 
follows: based on the descriptors of each PL, a set of HL-Skills is derived. They are used to design the first version 
of the questions of the certification tools. In parallel, HL-Skills and descriptors are used to derive the PL-Skills for 
the specific Level of Proficiency Level of the Competence. From each PL-Skill (or wherever possible, from 
multiple PL-Skills), the next step designs Examples of Use that are LinguaCuisine-specific. By using PL-Skills and 
Examples of Use, the process a) refines the questions previously designed with a goal to produce the minimum 
set of questions that cover most skills with the best possible quality of answers and b) design the answers for 
each question. Questions can be generic or LinguaCuisine-specific, with more focus on the latter. This process is 
repeated for every Competence included in the LCCF. The design of the mapping between dimensions and the 
production of the certification tools is depicted in figure 1. 

 

 

Figure 1 The Framework for mapping Competences to skills to Questions and Answers 

 

High-Level Skills (HL-Skills) presented in table 1 are used for designing an initial version of the questions of the 
certification tools. They are actually loosely formed groups of PL-Skills. They express mainly functional tasks in 
order to permit the design of practical questions (questions that assess the skills of a trainee in a specific 
context). They are mostly used in the design of Test II questions where the trainee must be given a specific task 
in a specific context (scenario) to perform and be rated by the trainer. Specific scenarios define, in a concrete 
way, the goals to be achieved and at the same time allow the trainee to focus on what is assessed and not in 
secondary tasks that are not under assessment. This guided method of certification reduces the workload of 
both the trainee and the trainer. Furthermore, it reduces the bias introduced by the distraction of the trainee by 
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secondary tasks. Test I questions are more detailed (since the set of PL-skills is quite larger than that of the HL-
skills), so HL-skills are used for refining the questions and calibration between Test I and Test II questions. 

 

Competence HL-Skills 

1.1: Browsing, searching and filtering data, 
information and digital content 

 

1.1.1 Define information needs 

1.1.2 Access a Search Engine 

1.1.3 Search using keywords 

1.1.4 Broaden, narrow or refine a search 

1.1.5 Search for items in the Recipe Builder 

1.1.6 Access data information and content and navigate 
between them 

1.2: Evaluating data, information and digital 
content 

1.2.1 Evaluate objectivity and credibility of online information  

1.3: Managing data, information and digital 
content 

1.3.1 Open and save content 

1.3.2 Organise and store content 

2.1: Interacting through digital technologies 2.1.1 Join apps for on-line interaction.  

2.1.2 Make a basic contact 

2.1.3 Make group communication 

2.1.4 Be aware of on-line risks, code of conduct 

2.1.5 Organise/manage on-line communities 

2.3: Engaging in citizenship through digital 
technologies 

2.3.1 Find information and services for engaging in citizenship 

2.3.2 Publish information relevant to citizenship issues 

2.3.3 Register in e-services for citizenship 

2.3.4 Use digital services to inform other people 

3.1 Developing digital content 3.1.1 Create basic content (image, audio, video) and upload it 
to Recipe Builder 

3.1.2 Edit basic content (image, audio, video, text) 

3.1.3 Combine basic media files to produce a multimedia 
presentation using the Recipe Builder 

 

TABLE 1. MAPPING OF HIGH LEVEL, LINGUACUISINE-SPECIFIC SKILLS (HL-SKILLS) 

 

The matrixes of sections 2.4, 2.5 and 2.6 present the mapping between Competencies PL-skills and Examples of 
use for all Competencies included in the LCCF and for Proficiency Levels 1-4. 

 



2.4 Information and data literacy Proficiency Levels- Skills mapping 

2.4.1 Browsing, searching, filtering data, information and digital content  mapping (1.1) 

The skills and usage scenarios related to this Competence are identified as follows: 

Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

 

Foundation 

 

 

 

 

 

 

1 

 

 

• To be able to Identify my 
information needs 

 

• Identify appropriate information sources 

• Know what a web browser is and identify the 
tasks it can be used for  

With the help of a Web expert, I can: 

• identify a search engine to use 

• identify a keyword that describes the type 
of the recipe I am looking for 

• To be able to find data, 
information and content 
through a simple search in 
digital environments,  

• Identify keywords that describe the 
information I need  

• Find data by performing simple keyword 
search on text search engines 

 

With the help of a Web expert I can: 

• open a web browser 

• use a one keyword text search to find 
details about a specific type of recipe 

 

• To be able to find how to 
access these data, 
information and content 
and navigate between 
them, 

• Understand the basic structure of web content 
(linked documents) 

• Understand the basic principles of web 
navigation (browsing) 

With the help of a Web expert I can: 

• access a specific recipe site from a list of 
search results using hyperlinks 

• navigate through search results and go back 
and forth  

• To be able to identify 
simple personal search 
strategies 

•  Understand what a search strategy is and the 
need to have one 

With the help of a Web expert I can: 

• search by subject using the type of the 
recipe 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

 

Foundation 

 

 

 

 

 

 

2 

 

 

• To be able to Identify my 
information needs 

 

• Identify appropriate information sources 

• Know what a web browser is and identify the 
tasks it can be used for 

With the help if necessary of a Web expert I can: 

• identify some search engines to use 

•  identify some keywords that describe the 
type of the recipe 

• To be able to find data, 
information and content 
through a simple search in 
digital environments,  

• Identify keywords that describe the 
information I need  

• Find data by performing simple keyword 
search on text search engines 

 

With the help if necessary of a Web expert I can: 

• use a text search engine to find details 
about a specific type of recipe 

 

• To be able to find how to 
access these data, 
information and content 
and navigate between 
them, 

• Understand the basic structure of web content 
(linked documents) 

• Understand the basic principles of web 
navigation (browsing) 

With the help if necessary of a Web expert I can: 

• access a specific recipe site from a list of 
search results using hyperlinks 

• navigate through search results and go back 
and forth 

• To be able to identify 
simple personal search 
strategies 

• Understand what a search strategy is and the 
need to have one 

With the help of a Web expert I can: 

• search by subject using the type of the 
recipe  
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

 

 

Intermediate 

 

 

 

 

 

 

 

3 

 

 

• To be able to explain my 
information needs 

• Use different search engines or specific 
portals 

• Identify most keywords that describe the 
information I need 

• Know the basic vocabulary that can be 
used to describe browsing, searching and 
filtering information 

On my own I can: 

• name the search engines or recipe portals I 
routinely use  

• identify most keywords that describe the 
type of the recipe 

• To be able to perform well-
defined and routine 
searches to find data, 
information and content in 
digital environments 

• Can access a web page directly (i.e. by 
typing the web address) 

By myself I can: 

• directly access a recipe search engine or a 
recipe blog 

• To be able to explain how to 
access them and navigate 
between them 

• Access a specific site from a list of search 
results 

• Access a resource from a list within a 
repository 

• Access a video 
 

By myself I can: 

• Access a specific recipe site from a list of 
search results using hyperlinks 

• Access a specific recipe site from a list of 
search results using filters 

• Access a video for a recipe I want to find by 
previewing 

• To be able to explain well-
defined and routine 
personal search strategies 

• Understand the role of keywords and the 
ways they can be combined to produce 
correct results  

• Edit keywords to improve the search 
outcome 

By myself: 

• I can evaluate which keywords produce 
correct results 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

 

 

Intermediate 

 

 

 

 

 

 

 

4 

 

• To be able to illustrate 
information needs 

 

• Use different types of search engines 

• Identify all keywords that describe the 
information I need 

• Extract keywords from a description, 
specification, or piece of text 

• I can name video search engines or recipe 
repositories when searching for recipes 

• I can identify all keywords that describe the 
type of the recipe 

• To be able to organise the 
searches of data, 
information and content 
in digital environments, 

 

 

 

• Can adjust search according to specific needs 

• Can use online social media tools to locate and 
view content  

• Can use other online tools (i.e. blogs, forums, 
social media, digital repositories, maps etc.) to 
access and retrieve content 

• I can perform different searches to locate a 
recipe 

• I can locate forums about specific types of 
recipes 

• To be able to describe 
how to access to these 
data, information and 
content, and navigate 
between them. 

• Access and navigate through the resources in a 
collection 

• I can access a specific recipe video from a 
collection using the navigation panel 

• To be able to organise 
personal search strategies 

• Understand the properties (qualities) of a good 
search strategy 

• I can organize the keywords that produce 
quality results by evaluating the results of 
past searches 
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2.4.2 Evaluating data, information and digital content  mapping (1.2) 

The skills and usage scenarios related to this Competence are identified as follows: 

Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

Foundation 

 

 

1 

 

 

To be able to detect the 
credibility and reliability of 
common sources of data, 
information and their digital 
content 

 

• Distinguish reputable and reliable information 
sources from others  

 

 

With the help of a Web expert I can: 

• Distinguish which recipe resources are more 
reliable by judging the reputation of the 
editor or the web host/owner 

• Distinguish which recipe resources are more 
reliable by using published lists of the most 
popular web sites 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

Foundation 

 

 

 

2 

 

• To be able to detect the 
credibility and reliability of 
common sources of data, 
information and their 
digital content 

 

• Find the information about a website's 
owner/provider 

• Detect Internet domain names and how they 
can help to assess the reliability of a website 

 

With the help if necessary of a Web expert I can: 

• Distinguish which recipe resources are more 
reliable by judging the reputation of the 
editor or the web host/owner 

• Distinguish which recipe resources are more 
reliable by looking at the date of the 
publishing of the information or how often 
this information is updated 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

Foundation 

 

 

 

 

 

3 

 

• To be able to perform the 
analysis, comparison and 
evaluation of the 
credibility and reliability of 
well-defined sources of 
data, information and 
digital content. 

 

 

• Evaluate information or content that I find 
online may, or may not be reliable, by looking 
at specific qualities of the content such as 
language, precision, appearance 

 

• Assess the reliability of a recipe site or a 
blog by checking if the ingredient list of 
recipes provided match the recipe 
instructions, if the language used is precise 
and serious  

 

• To be able to perform the 
analysis, interpretation 
and evaluation of well-
defined data, information 
and digital content 

 

• Interpret results to improve search procedures 

• Discern the advertisement and promoted 
content among the results of an online search 
and on social network pages 

 

• Edit keywords to locate more reliable web 
sites for recipes  

• I can evaluate which adds concerning 
cooking web sites are worth looking at 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

Foundation 

 

 

 

 

 

4 

 

• To be able to perform the 
analysis, comparison and 
evaluation of sources of 
data, information and 
digital content 

 

 

 

 

 

• Critically evaluate the credibility and reliability 
of non-web sources of data, information and 
content 

• Understand the properties of good quality 
unstructured content 

• Compare the outcome of different searches 

• assess the reliability of a recipe Facebook 
account by looking at the number of users 
following the account and the type of posts 
and comments 

• Compare the reliability of different recipe 
accounts on Facebook by comparing the 
number of followers and the quality and 
frequency of comments  

 

• To be able to perform the 
analysis, interpretation 
and evaluation of data, 
information and digital 
content 

• Use different information repositories and 
search strategies 

• Combine results from searches on Facebook 
and Google on a specific recipe 
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2.4.3 Managing data, information and digital content  mapping (1.3) 

The skills and usage scenarios related to this Competence are identified as follows: 

Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

 

 

 

 

Foundation 

 

 

 

 

 

 

 

 

 

1 

 

• To be able to identify how 
to organise, store and 
retrieve data, information 
and content in a simple way 
in digital environments. 

 

• Know the different digital content formats 

• Know the difference between online and offline 
storage 

• Know the basic content manipulation operations 
(open and save) 

 

With guidance, I can: 

• identify in which format I can save a 
recipe 

• identify in which format I can save an 
image 

• identify in which format I can save an 
audio file 

• identify in which format I can store the 
address of a web site  

• identify how to open a recipe/image I 
stored earlier in my storage device 

• save a web page/image/audio file/web 
address of a recipe resource to my 
desktop 

• open a file I saved earlier 

• To be able to recognize 
where to organise them in 
a simple way in a structured 
environment 

 

• Understand how information is stored on 
different devices/services 

• Understand how information can be organized in 
a storage device so as to be easily retrievable 

 

With guidance, I can: 

• understand how to choose the 
appropriate storage device to store my 
recipe video files 

• understand how to name the files  I am 
storing so as to easily retrieve them later 

• understand how to name the folders and 
subfolders that will store my data 

• understand which folders and subfolders I 
should create to store the files of a digital 
recipe I am going to put together 

• create a folder to store my recipe files 

• open a folder I created for storing images 
about a recipe 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

 

 

 

 

 

Foundation 

 

 

 

 

 

 

 

 

 

 

2 

 

• To be able to identify how 
to organise, store and 
retrieve data, information 
and content in a simple way 
in digital environments. 

 

• Know the different digital content formats 

• Know the difference between online and offline 
storage 

• Know the basic content manipulation operations 
(open and save) 

 

 

With the help of a friend if necessary I can: 

• identify in which format I can save a 
recipe 

• identify in which format I can save an 
image 

• identify in which format I can save an 
audio file 

• identify in which format I can store the 
address of a web site  

• identify how to open a recipe/image I 
stored earlier in my storage device 

• save a web page/image/audio file/web 
address of a recipe resource to my 
desktop 

• open a file I saved earlier 

• To be able to recognise 
where to organise them in 
a simple way in a structured 
environment 

 

• Understand how information is stored on 
different devices/services 

• Understand how information can be organized in 
a storage device so as to be easily retrievable 

 

With the help of a friend if necessary I can: 

• understand how to choose the 
appropriate storage device to store my 
recipe video files 

• understand the benefits/shortcomings of 
online and offline storage 

• understand how to name the files  I am 
storing so as to easily retrieve them later 

• understand how to name the folders and 
subfolders that will store my data 

• understand which folders and subfolders I 
should create to store the files of a digital 
recipe I am going to put together 

• create a folder to store my files 

• open a folder I created 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

Intermediate 

 

 

 

 

3 

 

• To be able to select data, 
information and content 
in order to organise, store 
and retrieve in a routine 
way in digital 
environments. 

• Open, copy and move files or folders inside a 
digital device  

• Save files and folders on external hard disk, 
USB memory, memory card 

• Use the browser to save browsing history 

• Move folder containing recipes for lasagna 
into a folder that contains all recipes for 
pasta 

• Save the address of a recipe you like as a 
bookmark 

• Retrieve a bookmark 

• To be able to organise 
them in a routine way in a 
structured environment 

• Structures and classifies information and 
content according to a standard classification 
scheme/method  

• Organize folders to use them as file 
repositories  

 

• Create notes about vegetarian salads using 
text and images and store them in 
appropriate file formats in different folders 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

Intermediate 

 

 

 

 

4 

 

• To be able to organise 
information, data and 
content to be easily stored 
and retrieved. 

• Understand basic backup policies 

• Save files and folders on a cloud service 

• Organise bookmarks in a browser  

• Save a folder with images of a recipe to 
iCloud 

• Create a backup of your files 

• Organise your recipe bookmarks to 
categories according to the type of the food 

• To be able to organise 
information, data and content in 
a structured environment 

• Uses various classification schemes to store 
and manage resources and information 

• Tag content 

• Use tag file properties to mark a folder that 
contains your most favorable recipes 

• Create and properly name a folder that 
organizes into subfolders, content of several 
different files formats (text, images, video, 
audio, hypertext, pdf) and of three different 
recipe themes (salads, stew, pasta) 
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2.5 Communication and collaboration Proficiency Levels- Skills mapping 

2.5.1 Interacting through digital technologies  mapping (2.1) 

The skills and usage scenarios related to this Competence are identified as follows: 

Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

 

 

Foundation 

 

 

 

 

 

 

 

1 

 

• To be able to select simple 
digital technologies to 
interact 

 

 

• I can distinguish between synchronous an 
asynchronous communication media and 
choose between them the most appropriate to 
the communication I want exchange. 

• Is aware of different digital communication 
means (e.g. email, chat, VoIP, video-
conference, SMS)  

• Knows how messages and emails are stored 
and displayed 

• Understand the services offered by social 
media tools  

• Understand privacy and safety risks associated 
with the use of digital content 

• Able to find relevant communities, networks, 
and social media that correspond to his/her 
interests and needs  

With guidance, I can: 

• Select an application that best fits my 
need to communicate with people 
sharing the same passion as me in 
cooking 

• Select the appropriate on-line 
community for discussing new trends in 
health foods 

• Select the appropriate mode of 
discussion when I need to talk privately 
with a peer 

• Sing-in in as a member in a forum 

• follow an account in Facebook or 
Twitter 

• Open an email or Skype account 
 
 

• To be able to identify 
appropriate simple 
communication means for 
a given context. 

 

• Is able to send an email, write a blog post 

• Is able to use a chat or a discussion forum to 
communicate with others 

• Is able to receive and make on-line calls and 
video calls over the Internet  

• I can send and receive e-mails (send, reply, 
forward)  

With guidance, I can: 

• post a message in a blog 

• make a Skype call 

• send an email 

• tweet a message 

• make comments is forums 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

 

 

Foundation 

 

 

 

 

 

 

 

2 

 

• To be able to select simple 
digital technologies to 
interact 

 

• I can distinguish between synchronous an 
asynchronous communication media and 
choose between them the most appropriate to 
the communication I want exchange. 

• Is aware of different digital communication 
means (e.g. email, chat, VoIP, video-
conference, SMS)  

• Knows how messages and emails are stored 
and displayed 

• Understand the services offered by social 
media tools  

• Understand privacy and safety risks associated 
with the use of digital content 

• Able to find relevant communities, networks, 
and social media that correspond to his/her 
interests and needs 

With the help of a friend if necessary I can: 

• Select an application that best fits my need 
to communicate with people sharing the 
same passion as me in cooking 

• Select the appropriate on-line community 
for discussing new trends in health foods 

• Select the appropriate mode of discussion 
when I need to talk privately with a peer 

• Sing-in in as a member in a forum for cooks 

• follow an account of a famous cook in 
Facebook or Twitter 

• Open an email or Skype account 

• Create and save contacts in my digital 
devices 

• To be able to identify 
appropriate simple 
communication means for a 
given context. 

 

• Is able to send an email, write a blog post 

• Is able to use a chat or a discussion forum to 
communicate with others 

• Is able to receive and make on-line calls and 
video calls over the Internet  

• I can send and receive e-mails (send, reply, 
forward) 

With the help of a friend if necessary I can: 

• post a message in a blog 

• make a Skype call 

• send an email 

• tweet a message 

• make comments in forums 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

Intermediate 

 

 

 

3 

 

• To be able to perform 
well-defined and routine 
interactions with digital 
technologies 
 

• Start a new online community 

• Start a new online discussion 

• Start a new online blog 

• Organise and moderate on-line events 
 

• Start a blog about your experience as a cook 

• Organise a Skype meeting with two of your 
friends that have similar interests in cooking 

• To be able to select well-
defined and routine 
appropriate digital 
communication means for 
a given context 

• Understand and use a code of contact 
 
 

• Create a personal profile on Facebook 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

Intermediate 

 

 

 

 

 

4 

 

• To be able to select a 
variety of digital 
technologies to interact 
 

• select appropriate application from a list of 
options depending on particular needs 

• select appropriate functions from a list of 
options of an application depending on 
particular needs 

• configure application 

• Configure Skype to use video and chat 
for showcasing in a live audience how to 
execute a difficult recipe 

• To be able to select a 
variety of appropriate 
digital communication 
means for a given context 

• Understand the importance of the virtual 
intentity and manage its properties 

• Able to identify privacy protection risks and 
apply measures 

• Manage conflicts that may occur among 
members in social media, networks and online 
communities  

• Able to moderate community content in social 
media 

• Select and use different tools for 
communicating depending on the purpose of 
the communication 

• Modify personal profile in various on-
line applications depending on the 
situation 

• Configure the properties of your 
discussion group in a forum for cooking 

• Use Instagram to post pictures of your 
dishes and Facebook to post the recipes 
and receive comments. 



The LinguaCuisine Certification system 

 

30 

 

2.5.2 Engaging in citizenship through digital technologies mapping (2.3) 

 

The skills and usage scenarios related to this Competence are identified as follows: 

Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

Foundation 

 

 

 

 

 

1 

 

• To be able to identify 
simple digital services in 
order to participate in 
society. 

 

• find and access the websites National and 
European Food Safety organizations, boards 
and NGOs 

• access a number of relevant networks and 
communities for different purposes  

• find relevant communities, networks, and 
social media that correspond to specific 
interests and needs  

With guidance, I can: 

• find and access the website of the National 
Food Administration or of the European 
Food Safety Authority or of he Committee 
on the Environment, Public Health and Food 
Safety 

• find and access the Facebook account of  
the Organic Consumer Association  

• To be able to recognise 
simple appropriate digital 
technologies to empower 
myself and to participate 
in society as a citizen 

• set up online accounts for private/public 
services 

• I can set up online accounts for private/public 
services, if that is requested to use the services 

 

With guidance, I can: 

• follow the Ecological Food and Farm 
Association on Twitter 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

Foundation 

 

 

 

 

2 

 

• To be able to identify 
simple digital services in 
order to participate in 
society. 

 

• find and access the websites National and 
European Food Safety organizations, boards 
and NGOs 

• access a number of relevant networks and 
communities for different purposes  

• find relevant communities, networks, and 
social media that correspond to specific 
interests and needs 

With the help of a friend if necessary I can: 

 

• find and access the website of the National 
Food Administration or of the European 
Food Safety Authority or of he Committee 
on the Environment, Public Health and Food 
Safety 

• find and access the Facebook account of  
the Organic Consumer Association 

• To be able to recognise 
simple appropriate digital 
technologies to empower 
myself and to participate 
in society as a citizen 

•  set up online accounts for private/public 
services 

• set up online accounts for private/public 
services, if that is requested to use the services 

 

With the help of a friend if necessary I can: 

• follow the Ecological Food and Farm 
Association on Twitter 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

Intermediate 

 

 

 

 

3 

 

• To be able to select well-
defined and routine digital 
services in order to 
participate in society 

 

 

•  Select an on-line web based service that 
empowers citizenship 

 

• Select and subscribe to the eNews service of 
the National School Lunch program for 
unprivileged children 

• To be able to indicate 
well-defined and routine 
appropriate digital 
technologies to empower 
myself and to participate 
in society as a citizen 

 

 

• fill-in online forms with personal data 

• post an opinion for a review site 

• send a complaint or other feedback to a 
service provider 

 

• sign-in to request to be a member in 
committee of the International Association 
of Food Protection and receive their 
newsletter 

• post a complaint  
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

Intermediate 

 

 

 

4 

 

• To be able to select digital 
services in order to 
participate in society. 

 
 

 

 

• Select an on-line social medium that empowers 
citizenship 

 

• Select a Twitter campaign that sought to 
empower the citizens of your city to 
participate in an event for the ban of 
synthetic crops  

• To be able to discuss 
appropriate digital 
technologies to empower 
myself and to participate 
in society as a citizen 

•  Inform other people about on-line campaigns 
and events 

• Email your friends the details of a Facebook 
campaign for using less sugar in peoples’ 
everyday diet 
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2.6 Competence area 3: Digital content creation  Proficiency Level -Skills mapping 

2.6.1 Developing digital content mapping (3.1) 

The skills and usage scenarios related to this Competence are identified as follows: 

Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

 

 

Foundation 

 

 

 

 

 

 

 

1 

 

• To be able to identify ways 
to create and edit simple 
content in simple formats 

• Identify basic categories of software content 
management applications 

• Identify basic editing functions of text (copy, 
cut, paste, clear, select, find) 

• Identify basic editing functions of audio (copy, 
cut, paste, clear, select) 

• Identify basic editing functions of images 
(copy, cut, paste, clear, select) 

• Identify basic editing functions of video (copy, 
cut, paste, clear, select) 

 

With the guidance of my tutor  

• I can identify what type of applications I 
need to create content a video for my digital 
recipe scenario 

• I can identify what type of applications I 
need to create audio content for my digital 
recipe scenario 

• I can identify what type of applications I 
need to create an image for my digital 
recipe scenario 

• I can identify what type of applications I 
need to create text for my digital recipe 
scenario 

• I can identify what type of applications I 
need to edit the videos I created for my 
digital recipe scenario 

• I can identify what type of applications I 
need to edit the images I created for my 
digital recipe scenario 

•  I can identify what type of applications I 
need to edit the audio files I created for my 
digital recipe scenario 



The LinguaCuisine Certification system 

 

35 

 

• To be able to choose how I 
express myself through 
the creation of simple 
digital means 

• choose apps that suit my purpose by 
identifying the capabilities and services offered 
by them 

• choose apps that suit my purpose by 
identifying which apps can be used to produce 
each content format 

• create an efficient content development task 
plan by choosing from a list of available tools 
and devices 

• choose devices that express in other forms my 
creation 

 

• With help from a YouTube video I can 
choose the right video management app for 
the operating system in my tablet. 

• With help from a tutor I can identify app 
that manage audio and produce mp3 files as 
an output. 

• With the help of a tutor I can identify which 
apps I need to use for managing different 
content for my digital recipe. 

• With the help of a tutor I can identify apps 
that let me print my text files 

• With the help of a tutor I can identify apps 
that permit me to save my text files as web 
documents 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

 

 

 

 

 

Foundation 

 

 

 

 

 

 

 

 

 

 

2 

 

• To be able to identify ways 
to create and edit simple 
content in simple formats 

• Identify basic categories of software content 
management applications 

• Identify basic editing functions of text (copy, 
cut, paste, clear, select, find) 

• Identify basic editing functions of audio (copy, 
cut, paste, clear, select) 

• Identify basic editing functions of images 
(copy, cut, paste, clear, select) 

• Identify basic editing functions of video (copy, 
cut, paste, clear, select) 

• Identify how to upload content onto on-line 
platforms and repositories 

 
 

At class, with the help of my tutor who I can 
consult whenever I need: 

• I can identify what type of applications I 
need to create content a video for my digital 
recipe scenario 

• I can identify what type of applications I 
need to create audio content for my digital 
recipe scenario 

• I can identify what type of applications I 
need to create an image for my digital 
recipe scenario 

• I can identify what type of applications I 
need to create text for my digital recipe 
scenario 

• I can identify what type of applications I 
need to edit the videos I created for my 
digital recipe scenario 

• I can identify what type of applications I 
need to edit the images I created for my 
digital recipe scenario 

•  I can identify what type of applications I 
need to edit the audio files I created for my 
digital recipe scenario 

• I can identify how to upload content onto 
the LinguaCuisine platform 

• To be able to choose how I 
express myself through the 
creation of simple digital 
means 

• choose apps that suit my purpose by 
identifying the capabilities and services offered 
by them 

• choose apps that suit my purpose by 
identifying which apps can be used to produce 

At class, with the help of my tutor who I can 
consult whenever I need: 

• I can choose the right video management 
app for the operating system in my tablet 
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each content format 

• choose devices that express in other forms my 
creation 

• create an efficient content development task 
plan by choosing from a list of available tools 
and devices 

• I can identify apps that manage audio and 
produce mp3 files as an output 

• I can identify apps that manage images and 
produce jpg files as an output 

• I can identify apps that manage text and 
produce Word files as an output 

• I can identify apps that let me print my text 
files 

• I can identify apps that permit me to save 
my text files as web documents 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

 

 

Intermediate 

 

 

 

 

 

 

 

3 

 

• To be able to indicate 
ways to create and edit 
well-defined and routine 
content in well-defined 
and routine formats 

• apply basic operations (new file, type, save) for 
text creation 

• apply basic create operations (record, save) for 
audio creation 

• apply basic operations (record, save) for video 
creation 

• apply basic operations (record, draw, save) for 
image creation 

• create text files in  in different formats (Word, 
txt) 

• create audio files in  in different formats (mp3, 
au) 

• create video files in  in different formats (mp4, 
avi) 

• create image files in  in different formats (jpg, 
gif) 

• Edit (copy, cut, paste, clear, select) text files 

• Edit (copy, cut, paste, clear, select) audio files 

• Edit (copy, cut, paste, clear, select) video files 

• Edit (copy, cut, paste, clear, select) image files 

• Upload content onto on-line platforms and 
repositories 

 

• Open a video you created for the execution 
of your recipe and save it with a new name 
that includes your name and the title of the 
recipe 

• Record a video for you recipe and save it 
using the MP4 format 

• Record audio for your recipe and save it as 
an MP3 file 

• Take a picture during the execution of your 
recipe and save it as a JPG file 

• Create a text that describes the exact steps 
for executing your recipe and save it as a 
Word file 

• Upload a video you created during the 
execution of your recipe onto the recipe 
builder  

• Open a video you created for the execution 
of your recipe and save it with a new name 
that includes your name and the title of the 
recipe 

• Upload a video onto the LinguaCuisine 
platform 

• To be able to express 
myself through the 
creation of well-defined 
and routine digital means 

• use apps for content creation that suits my 
purpose by identifying the capabilities and 
services offered by them 

• use devices that express my creation in other 
means 

 

• Use the default printer to print a Word file 
that contains text describing your recipe 

• Use Powerpoint to create a presentation of 
your digital story 
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Proficiency lvl Descriptor PL-Skills Examples of use 

 

 

 

 

 

 

Intermediate 

 

 

 

 

 

 

4 

 

• To be ably to indicate 
ways to create and edit 
content in different 
formats 

• configure the app that creates the content so 
as to achieve the best quality in relation to 
the setting 

• choose the right format (to save my files) for 
the indented purpose 

• manipulate size of output file during content 
creation by configuring the content 
attributes 

• upload content onto online platforms 
depending on its format and size 

• I can tell a friend what format to choose to 
save his video depending on its duration 

• I can deal with problems concerning the 
configuration of the save setting of an 
image I created  

• I can deal with problems concerning 
which cloud storage service to use to 
upload all the pictures I created during the 
recipe course over a 3G network 

• To be able to express 
myself through the 
creation of digital means 

• use apps for content creation that suits my 
purpose by identifying the capabilities and 
services offered by them 

• use devices that enchase my creation in other 
means 

 

• I can tell a friend which app to use on his 
mobile phone so as to record small videos 
in a room with low light conditions 

• I can deal with problems concerning noise 
in my recorded audio by using an app that 
automatically removes background 
sounds   

• I can find and select a suitable printer in 
the network to print a Word file that 
contains text describing my recipe 

• I can use Powerpoint to create an 
automated presentation of my digital 
story 

• I can save my text in Acrobat format (pdf) 
• I can use an app to help me add music to 

my video 



 

3. CERTIFICATION TOOLS AND GRADING  

3.1 The Certification tools  

3.1.1 TEST I 

The goal of this certification tool is to provide detailed information on the Proficiency Level of the trainee by 
assessing a wide range of PL-Skills according to the mapping of the LCCF. It is a multiple-choice test including 
questions that are grouped by DigComp’s competences. Trainees can only give one answer to the multiple-
choice questions. Answers are designed so as to reflect different digital PLs. A question has answers 
corresponding to all PLs (one for each level) plus answers that are false. Thus, by choosing a specific answer, the 
trainee is mapped to a PL and awarded specific points (figure 2).   

 

Figure 2 Structure of a question of Test I 

Ideally, a scoring strategy should correctly measure the knowledge of the trainee, but trainees may attempt 
(unconsciously or consciously) to guess answers rather than admit ignorance. Thus, the interplay between the 
scoring strategy and the student's strategy must be considered. To this end, one or two additionally false 
answers are added to each question. The score for choosing a false answer is 0. This highlights a need to 
distinguish between guessing and giving wrong answers in good faith.  

This question design strategy has several advantages. Partial knowledge is credited and scoring somewhat 
straightforward and thus the transformation to a grade on scale for a specific Competence is direct. This means 
that there is no need to apply calibration as in the case of questions corresponding only to one PL. Furthermore, 
by assigning all PLs to one question, the test is more compact and less questions are needed in total for the 
certification. Having in mind the large number of skills identified in the LCCF and the use of two certification 
tools (Test I and Test II), this is a significant parameter. Finally, it must be noted that the scale used by the LCCF 
is independent of the number and type of questions used in the assessment tools. If a median score was to be 
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used then calibration should take place to calculate the exact range of each PL for a specific set of questions. If 
questions were to be changed, the calibration process should be repeated. It is obvious that when calibration is 
involved (that is, testing with at least 100 participants to derive the ranges) for each specific set of questions the 
effort of certifying becomes large.  The use of the median method (also discussed in 3.2) 

The main disadvantage of this method is the need to design answers for each PL. This is a difficult task since the 
burden of designing different questions for each PL is shifted to designing different answers for each PL. This 
method is more easily applied to observation tests. When the number of PLs is large, designing answers get 
more difficult. This obstacle can be overcome by designing questions that correspond to similar PLs (as defined 
in DIGCOMP 1 vs. 2.1): Foundation Level (PLs 1/2), Intermediate Level (PLS 3/4), Advanced Level (PLs 4/5) and 
Highly Specialised (PLs 7/8). This is a two-dimensional organisation of both questions and answers. 

The score of a Competence C which is certified by k questions qk is calculated as follows: 

𝑆𝑐𝑜𝑟𝑒(𝐶) =∑𝑠𝑐𝑜𝑟𝑒(𝑞𝑖)

𝑘

𝑖=1

 

where  

𝑠𝑐𝑜𝑟𝑒(𝑞𝑖) =

{
 
 

 
 
1, 𝑖𝑓 𝑎𝑛𝑠𝑤𝑒𝑟 𝑖𝑠 𝑃𝐿1
2, 𝑖𝑓 𝑎𝑛𝑠𝑤𝑒𝑟 𝑖𝑠 𝑃𝐿2
3, 𝑖𝑓 𝑎𝑛𝑠𝑤𝑒𝑟 𝑖𝑠 𝑃𝐿3
4, 𝑖𝑓 𝑎𝑛𝑠𝑤𝑒𝑟 𝑖𝑠 𝑃𝐿4
0, 𝑖𝑓 𝑎𝑛𝑠𝑤𝑒𝑟 𝑖𝑠 𝑓𝑎𝑙𝑠𝑒

 

Thus the maximum points awarded to an answer is 4 points and the minimum, 0 points. If there are k questions 
assigned to a Competence then the maximum points awarded are k*4 and the minimum, 0 points. 

Each Competence is generally assessed by the same number of questions. A minimum of 4 questions and a 
maximum of 8 questions per Competence are used in LinguaCuisine. 

The mapping of Competences to PL-Skills and then to questions for Test I is presented in section 3.3. 

3.1.2 TEST II 

This is an observation test where the trainee is asked to perform simple tasks. Each task is assessed by one 
question. Tasks correspond to PL-skills of various PLs. The trainer observes the reaction of the trainee and assess 
the way that the latter executes a task. There are various ways of executing a task, organized into patterns of 
behaviour. These patterns are, just like the answers of the questions of Test I, mapped to each one of the 4 PLs. 
The trainer selects the pattern (thus, the Proficiency Level) of the behaviour (the closest one) the trainee has 
exhibited when executing a task and a score is assigned. Scores range from 1 (for PL 1 related behaviour to 4 – 
PL 4 related behaviour). A score is derived for each question. Competence score is calculated in the same way as 
in Test I and using a predefined scale, it is translated into a PL for the whole Competence. There is thus 
conformity between the design principles of Test I and Test 2. 

For the successful execution of Test II, the trainer needs to be well informed about the differences between 
Proficiency Levels in DIGCOMP. He must also be able to distinguish between different patterns of behaviour 
(ways of executing the task) so as to successfully select the pattern that is closer to the one the trainee actually 
exhibited. In order to help the trainer in this task, each question contains a brief description of the scenario and 
context of the task to be performed by the trainee. These scenarios must be designed and tested for practicality 
(that is, whether they can be performed at some degree even by a Proficiency Level 1 trainee). In contrast to 
Test I questions, Test II questions are not theoretic but require execution in real conditions. 
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A question of Test II gives exactly four choices to the trainer. One of the choices is standard and corresponds to 
Proficiency Level 1 behaviour: ‘Can do with assistance’. The other three choices depend on the Competence and 
skills under assessment (figure 3). 

 

Figure 3 Structure of a question of Test II 

Test II is designed to assess each Competence using 5-8 questions. 

3.2 Grading method 

The scoring strategy assigns a numeric score to a Competence, but this must be transformed into a grade on 
some scale so as to derive a decision about the Proficiency Level. The basic idea behind this transformation is 
that a threshold of more than 50% of the maximum score (>50%) of a Proficiency Level must be obtained for the 
Competence to be assigned at that level.  

The maximum score of a Proficiency Level i in a set of k questions assigned to a Competence is calculated by the 
product: 

MaxScore(i)= k*i, with i=1,2,3,4 

This result is easily calculated since an answer that corresponds to Proficiency Level i is awarded with a score of i 
points (table 2).  

Proficiency Level Max Score of PL 

1 k*1 

2 k*2 

3 k*3 

4 k*4 

TABLE 2. MAXIMUM SCORE FOR A SET OF K QUESTIONS ASSESSING A COMPETENCE 
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The threshold of 50% for each level produces a range of values for transforming a Competence score to a 
Proficiency Level.  

The upper limit of the range of level i of a Competence C that is certified by k questions, (where k is an odd 
number) is: 

𝑈𝑝𝐿𝑖𝑚𝑖𝑡(𝐶𝑖) = ⌈
𝑘

2
⌉ 𝑖+⌊

𝑘

2
⌋ (𝑖 + 1) 

The upper limit of the range of level i of a Competence C that is certified by k questions, (where k is an even 
number) is: 

𝑈𝑝𝐿𝑖𝑚𝑖𝑡(𝐶𝑖) =
𝑘

2
𝑖+
𝑘

2
(𝑖 + 1) − 1 

      For Test I, the minimum score value of a Competence is zero and the maximum is k*4 (table 3): 

Proficiency Level (i) Range 

1 [0, Uplimit(C1)] 

2 [Uplimit(C1)+1, Uplimit(C2)] 

3 [Uplimit(C2)+1, Uplimit(C3)] 

4 [Uplimit(C3)+1, k*4] 

TABLE 3. RANGE OF VALUES FOR CALCULATING THE PROFICIENCY LEVEL FROM A COMPETENCE SCORE (TEST I) 

 

For Test ΙI, the minimum score value of a Competence is k and the maximum is k*4 since there are no answers 
awarding 0 points (table 4): 

Proficiency Level (i) Range 

1 [k, Uplimit(C1)] 

2 [Uplimit(C1)+1, Uplimit(C2)] 

3 [Uplimit(C2)+1, Uplimit(C3)] 

4 [Uplimit(C3)+1, k*4] 

TABLE 4. RANGE OF VALUES FOR CALCULATING THE PROFICIENCY LEVEL FROM A COMPETENCE SCORE (TEST II) 

 

The threshold for odd numbers practically means that if more than 50% (>50%) of the answers correspond to 
level i, then the certificate is awarded to that Proficiency Level. An assumption is made that within the 
assessment of a Competence, answers usually vary between neighbouring levels (e.g. between Level 1 and 2 or 
level 2 and 3 etc.). Significant PL variations in answers constitute outlier cases which are difficult to manage. 

The threshold for odd numbers practically means that, in the worst case, where half of the answers correspond 
to level i and the other half to level i+1, then the largest level prevails.  

The method presented above deals better with marginal cases (as described above) than the more simplistic 
one of dividing the 0-k*4 range to four equal intervals (0-25%, 26%-50%, 51%-75% and 76%-100) or even the 
modified four-level Danish scale (0-22.5%, 23%-50%, 51%-77,5%, 78%-100%). Cases of outliers cannot be 
managed well by any method. For example, in a case where a trainee chooses answers that correspond to all 
five levels within a Competence, a specific PL cannot be easily derived. In this case, the median is calculated. 
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Outliers are caused when a trainee answers questions in a random way (the presence of false answers reduces 
significantly the appearance of such outliers) or when the questions are not designed correctly. The presence of 
outliers is more probable to appear in Test I than in Test II (the latter is conducted by an expert and is thus 
considered more reliable). 

The Score Mapping to PL certification table for the set of 41 questions of the LinguaCuisine Test I is presented 
along with the Skills-Questions-Answers matrix (section 3.3). The matrix also contains the points awarded from 
each answer of a question. 

The score mapping to level certification table for the set of 31 questions of the LinguaCuisine Test II is presented 
within the test, after the set of questions assessing a Competence (Appendix II). 

3.3 Proficiency Level Awarding  

Each one of the tests produces a result for each Competence, used to derive the final Proficiency Level. If the 
results of both tests for a certain Competence are in agreement, then the Certificate is awarded for the common 
PL derived. If the results are in disagreement, then the result of Test II prevails and the corresponding PL is 
derived as final. 

The reason for choosing the result of Test II over the one of Test I is that, generally, controlled assessments with 
the participation of experts are more reliable than multiple-choice questions quizzes. Furthermore, it is not safe 
to combine the results of both tests because a Competence may be assessed by a different number of questions 
in Test I than in Test II. Range of values for the calculation of the final Proficiency Level will also differ, not only 
because of the number of the questions but because of the different minimum value of the 1st range (tables 3 
and 4). 

 



3.4 The Skills-Questions-Answers Matrix for Test I  

Competence 1: Information and data literacy 

 

3.4.1 Browsing, searching, filtering data, information and digital content examples of use  (1.1) 

 
Descriptors (DIGCOMP) Skills Related Questions Answers [Score]  

• Identify my information 
needs (1&2) 

• Explain my information 
needs (3) 

• Illustrate Information needs 
(4) 

• Identify a web browser to use 

• Explain a web browser to use 

• Identify a web browser to use 

• Illustrate a web browser to use 

A.1. To start an online search, the first thing 
you need to do is to open an app. Which one? 
 

1. I need help from an expert to understand what 
to open[1] 

2. Internet Explorer or Mozilla [2] 
3. I choose any web browsers for all kind of needs 

[3] 
4. Internet Explorer [1] 
5. I choose a web browser that is supported in my 

platform [4] 
6. Facebook or Twitter [0] 
 
 

• Can use a search engine to find data 
through a simple search                             

• Can use a search engine to find data 
through a simple search in digital 
environments                                      

• Can name and use search engines to 
find data       

• Can organise the searches of data, 
information and content in digital 
environments 

Α.2. You need to select a specific search 
engine in your tablet. Which application 
allows you to gain access to the World Wide 
Web? 
 

1. Firefox or Internet Explorer [0] 
2. Google [1] 
3. Google or Yahoo! [2] 
4. There are many search engines to choose from 

such Google, Bing, AOL etc. [3] 
5. Depending on the type of information I looking 

for I choose different search engines [4] 
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• Find data, information and 
content through a simple 
search in digital 
environments (1&2) 

• Perform well-defined and 
routine searches to find data, 
information and content in 
digital environments (3) 

• Organise the searches of 
data, information and 
content in digital 
environments (4) 

• Identify keywords that describe the 
information I need  

• Find data by performing simple 
keyword search on text search 
engines 

• Can access a web page directly (i.e. by 
typing the web address) 

• Can adjust search according to 
specific needs 

• Can use online social media tools to 
locate and view content  

• Can use other online tools (i.e. blogs, 
forums, social media, digital 
repositories, maps etc.) to access and 
retrieve content 

Α.3 You want to search for Italian recipes for 
pasta with sauce. Which keywords are you 
going to use?  
 
 

1. I need to use the “Pasta” keyword [2] 
2. “Pasta” AND   “Italian Recipes” [3] 
3. “Pasta” AND “Italian Recipes” AND “sauce” [4] 
4.  I need help to decide [1] 
5. I access a web page directly by typing a web 

address [0] 
 
 

 

• Find how to access these 
data, information and 
content and navigate 
between them (1&2) 

• Explain how to access them 
and navigate between them 
(3) 

• Describe how to access to 
these data, information and 
content, and navigate 
between them (4) 

• Can understand the basic structure of 
web content (linked documents) 

• Can understand the basic principles of 
web navigation (browsing) 

• Can access a specific site from a list of 
search results 

• Can access a resource from a list 
within a repository 

• Can access a video 

• Can access and navigate through the 
resources in a collection 

 A.4. You find many websites that contain 
information about Italian recipes for pasta. 
You want to visit the first 5 results of the 
search.  
 

1. I navigate among the pages (backwards, 
forward) by myself [2] 

2. I navigate a website's pages through hyperlinks 
[3] 

3. The buttons of the browser (forward, back) are 
used for navigating in lists [0] 

4. I navigate a website's pages through text, image 
hyperlinks and menus [4] 

5. I need help to navigate among the pages [1] 
6. The green letters are used for navigating to a 

result [0] 
 
 

A.5 You want to find videos that display the 
execution of a recipe for a Greek salad. A 
friend presents to you a relevant video 
collection with 50 videos, from YouTube. You: 
 

1. think it is easier to Skype a Greek person and ask 
how to make the salad[0] 

2. ask a web technician to help you install the 
software needed to watch the videos [1] 

3. navigate through the videos using the collection 
panel buttons [3] 

4. watch all the videos in the collection one after 
the other until you reach the one that really 
interests you [2] 
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5. inspect the videos and refine the search to get 
more accurate results [4] 
 
 

A.6 I want to access the recipe builder 
functions. I open a browser and access the 
web address of the builder.  Then: 
 

1. I use my Google account to log-in and access the 
functions [4] 

2. I use my Facebook account to log-in and access 
the functions [0] 

3. I need help from the tutor to access the builder 
[1] 

4. I use an existing account to log-in[3] 
5. I need to login to access the functions [2] 
6. No login information is needed, the service is 

free [0] 

A.7 Having logged-in to the Recipe Builder I 
want to navigate through the resources and 
structure. 

1. I navigate using the Back and Forward buttons 
of the browser [0] 

2. I need to use the proper buttons with the 
symbols [2] 

3. I navigate using the buttons on the ribbons of 
the builder in the top of the screen [3] 

4. I navigate using the buttons on the ribbons of 
the builder in the top, middle and bottom of the 
screen [4] 

5. I navigate using the menu of the builder and in 
the top of the screen [0] 

6. I ask my tutor to help me how to navigate [1] 

• Identify simple personal 
search strategies (1&2) 

• Explain well-defined and 
routine personal search 
strategies (3) 

• Organise personal search 
strategies (4) 

• Understand what a search strategy is 
and the need to have one 

• Understand the role of keywords and 
the ways they can be combined to 
produce correct results  

• Edit keywords to improve the search 
outcome 

• Understand the properties (qualities) 
of a good search strategy 

A.8 You perform a search for finding the 
ingredients of ‘Pasta Flora’ and you end up 
with results describing the flora of the Sahara 
desert. What do you do? 

1. I use another search engine and do the same 
search [2] 

2. I expand the keywords I used for searching to 
include the keyword ‘recipe’ [3] 

3. I do the search again with the help of an expert 
[1] 

4. I restart the browser to erase the search 
memory [0] 

5. Navigate to the results and try to find the recipe 
[0] 

6. I remember the keywords I used in previous 
searches with good results and adjust the search 
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terms.[4] 
 

A.9 You are finalizing the list of ingredients 
that you want to use in your recipe. You need 
to search for tomato sauce pictures, your last 
ingredient. You also need utensils’ photos. 

1. You can search for ingredient pictures in the 
recipe builder [2] 

2. You need help from a tutor to decide [1] 
3. The recipe builder does not contain any 

utensils repository [0] 
4. You search for ingredient pictures and 

utensils in the recipe builder using 
keywords [4] 

5. You search for ingredient pictures in the 
recipe builder using a keyword [3] 

6. You search for ingredient pictures in the 
recipe builder using the tags in the pull 
down menu [0] 
 

 

Min Score for certifying this Competence: 0 points. Max Score for this Competence: 36 points 

Score mapping to PL certification: 

Score range PL Result 

0-13 1-Basic   

14-22 2-Basic   

23-31 3-Intermediate   

32-36 4-Intermediate   
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3.4.2 Evaluating data, information and digital content (1.2) 

 
Descriptors (DIGCOMP) Skills Related Questions Answers [Score] 

• To be able to detect the 
credibility and reliability of 
common sources of data, 
information and their digital 
content (1&2) 

• Distinguish reputable and reliable 
information sources from others  

• Find the information about a 
website's owner/provider 

• Detect Internet domain names and 
how they can help to assess the 
reliability of a website 

A.10 You are reading an article on a blog 
stating that consuming meat is dangerous. 
How could you assess the credibility of the 
content of this article? 
 
 

1. With the help of an expert I shall check the 
author’s information [1] 

2. I shall check when the article was written and 
how often is the site updated [2] 

3. I shall check when the article was written and if 
the author is famous [2] 

4. It is not necessary to assess the content of this 
article because information on the internet is 
often credible [0] 

5. I shall search on Google to verify the basic facts 
of the article [3] 

6.  I shall search in at least two search engines and 
medical sites using as keywords the title of the 
article, to verify the facts of the article [4] 

• To be able to perform the 

analysis, comparison and 

evaluation of the credibility 

and reliability of well-defined 

sources of data, information 

and digital content (3) 

• To be able to perform the 

analysis, comparison and 

evaluation of sources of 

data, information and digital 

content (4) 

• Evaluate information or content that I 
find online may, or may not be 
reliable, by looking at specific 
qualities of the content such as 
language, precision, appearance 

 

A.11 A friend recommends an article on a blog 
on how to prepare vegetarian meals. You 
evaluate the credibility of the article by: 

1. the sponsors of the blog [1] 
2. the precision of the language used to describe 

the recipes [3] 
3. the number of users commenting the article [2] 
4. the ratings for the article as they are provided 

by the users[4] 
5. the number and quality of advertisements in the 

site [0] 
 

• Critically evaluate the credibility and 
reliability of non-web sources of data, 
information and content 

• Understand the properties of good 
quality unstructured content 

• Compare the outcome of different 
searches 

A.12 An email advertisement prompts you to 
follow a ‘Healthy Recipes’ account on 
Facebook. You want to check its credibility so 
you: 

1. check the number of users following the 
account [2] 

2. read the user comments on the first 3 recipes 
and if they are positive you continue to read 
more till you are convinced [3] 

3. cross-check the content of the recipes with 
results you found on the subject from other 
sources like Google and YouTube [4] 

4. need help to decide if the posts are credible [1] 
5. execute the more recent recipe posted and 

invite your boss for dinner [0] 
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• To be able to perform the 
analysis, interpretation and 
evaluation of well-defined 
data, information and digital 
content (3) 

• To be able to perform the 
analysis, interpretation and 
evaluation of data, 
information and digital 
content (4) 

• Interpret results to improve search 
procedures 

• Discern the advertisement and 
promoted content among the results 
of an online search and on social 
network pages 

• Use different information repositories 
and search strategies 

A.13 You want to learn to cook using authentic 
German recipes for stew. Some of the 
resources you find are written in German, 
others are written in English. How are you 
going to find out, which are appropriate?   

1. You become member in forums and Facebook 
groups that publish information that you are 
interested in to use and ask for advice [4] 

2. You ask a friend that speaks German to help you 
[1] 

3. You search for ‘German cooking’ in Google and 
then refine the results using subject related 
keywords. [3] 

4. You use automatic translation to evaluate what 
is appropriate in your case [2] 

5. You try to understand what the recipes mean by 
looking at the accompanying pictures [0] 
 

A.14 You show a television show hosting a 
famous cook and you want to learn more 
about him and his accomplishments. You are 
eager to talk about what you learned in the 
cooking lesson next week. What do you do? 
 

 

1. You read the relevant Wikipedia article  [2] 
2. You Google his name but you need help from a 

friend to select what to read [1] 
3. You join a forum and ask the other users about 

him [0] 
4. You search for articles in electronic newspapers, 

magazines and official cooking sites [4] 
5. You email him and ask for more information [0] 
6.  You search in Google, Facebook and Cooking 

blogs to discover what people are saying about 
him [3] 

 

A.15 You are using the search function of the 
recipe builder to find information and pictures 
of healthy ingredients other people have 
uploaded onto the app. You enter the search 
terms ‘healthy’ and a list of 5 results appears. 
In which characteristics of each result do you 
pay attention in order to decide if it is the one 
you are looking for? 

1. I need help from a tutor to decide how to assess 
the quality of the results [1] 

2. I examine the video of the ingredient in order to 
decide [0] 

3. I look at the title of each result, I examine the 
image and listen to the audio describing the 
ingredient. [4] 

4. I look at the title of each results and the image 
describing the ingredient[3] 

5. I look at the title of each result, the image and 
read carefully the comments made by users to 
decide [0] 

6. I need to look at characteristics that describe 
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the ingredient [2] 

 

Min Score for certifying this Competence: 0 points. Max Score for certifying this Competence: 24 points 

Score mapping to level certification: 

Score range PL Result 

0-8 1-Basic   

9-14 2-Basic   

15-20 3-Intermediate   

21-24 4-Intermediate   
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3.4.3 Managing data, information and digital content (1.3) 

 
Descriptors (DIGCOMP) Skills Related Questions Answers [Score]  

• To be able to identify how to 
organise, store and retrieve 
data, information and 
content in a simple way in 
digital environments. (1&2) 

 

• Know the different digital content 
formats 

• Know the difference between online 
and offline storage 

• Know the basic content manipulation 
operations (open and save) 

 

A.16 How can you save a blog about Salad 
recipes in your desktop and then view it 
offline? 
 
 

 
 
 

1. I need help to save this information [1] 
2. I click on Menu -> File-> Save as… [2] 
3. I write down the address of the blog and then 

type it every time I go online [0] 
4. I bookmark the web address of the blog [3] 
5. I save the blog address in my favourites and 

organize it later in my bookmarks [4] 
 

 

A.17 At last you found the ideal appearance of 
a green salad in an image that appears in a 
cooking web site.  How can you save it in 
order to upload it later to the recipe builder?  
 
 

1. You click ‘Print’ from the menu in order to make 
it a poster in your room [0] 

2. You left click on the image until it downloads 
completely [0] 

3. I need help form an expert to do that! [1] 
4. I ‘ll probably use a Save function but I will ask for 

help from a friend on how to do that [2] 
5. I will right click and save the image on my 

desktop [3] 
6. I will right click and save the image on a folder 

named “Favourite Recipe Images” [4] 
 
 

• To be able to recognise 
where to organise them in a 
simple way in a structured 
environment (1&2) 

• Τo be able to select data, 
information and content in 
order to organise, store and 
retrieve in a routine way in 
digital environments. (3) 

• To be able to organise 
information, data and 

• Understand how information is stored 
on different devices/services 

• Understand how information can be 
organized in a storage device so as to 
be easily retrievable 

A.18 After a tedious search, at last you have 
found a lot of information on Thai food. This 
includes text and images from Google and 
videos from YouTube. How are you going to 
store the videos? 
 
 
 

1. I shall ask my friend to help decide where to 
store them [1] 

2. I ‘ll probably save them in my desktop after I ask 
a friend of mine who is a computer expert [2] 

3. I shall use the ‘Save as…’ command to store the 
videos to my flash disk [0] 

4. I shall store the web addresses of the videos to 
my electronic notes [3] 

5. I shall add the addresses as bookmarks to my 
Recipe Video bookmarks [4] 
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content to be easily stored 
and retrieved. (4) 

• Open, copy and move files or folders 
inside a digital device  

• Save files and folders on external hard 
disk, USB memory, memory card 

• Use the browser to save browsing 
history 

A.19 A friend of yours asks you to give him all 
the data concerning recipes you have stored 
and organized in folders, in your computer this 
year. You: 
 
 
 

1. need his help to transfer the files [1] 
2. shall probably copy them one by one to disk 

after you ask a computer expert [2] 
3. shall use the ‘Save as…’ command to store the 

videos to my flash disk [0] 
4. shall copy and paste the data folders to a flash 

drive [3] 
5. shall make them temporarily available in your 

iCloud account for him to download [4] 
6. shall connect a cable to your computer and 

transfer the data [0] 
 

A.20 You return to the course after a break 
and you continue to design your recipe of ‘Hot 
Spice Lasagna’ on the LinguaCuisine builder. 
Your tablet has restarted.  You need continue 
what you have done before the break, so you 
access the builder and: 

1. you need to load the recipe and you may need 
help from a friend to do that [2] 

2. you need to get help from a friend that has 
already used the builder more times than 
yourself [1] 

3. you choose ‘Load’ from the File menu and then 
enter the name of the ingredient Hot Spice [0] 

4. you choose ‘Load’ from the File menu and then 
enter the name of the ingredient Hot Spice [2] 

5. you press the ‘Load’ button from the ribbon [3] 
6. you press the ‘Load’ button from the ribbon and 

then tick the field ‘Completed recipes only’ [0] 
you press the ‘Load’ button from the ribbon and 
then select the name of the recipe from the 
available recipes[4] 

• Understand basic backup policies 

• Save files and folders on a cloud 
service 

• Organise bookmarks in a browser 

A.21 You have week to create 3 digital stories 
on how to cook baked lasagna, lasagna ala 
Muerte and lasagna Napolitana. You will need 
text, audio files, images and video for each 
recipe or ingredient to create the stories and 
you need to organize the content before you 
upload it to the recipe builder. You:  

1. ask the help of a friend to advice you how to 
organize the files [1] 

2. shall probably organize the files by ingredient 
after you ask a computer expert [2] 

3. shall store everything on the desktop for easy 
access [0] 

4. shall create folders and sub-folders per 
ingredient and then organize the files by type [3] 

5. shall decide first on the naming principles of the 
structure you are going to use and then store 
the files in subfolders according to the recipe, 
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ingredient and file type [4] 
6. shall download the files from the Web when 

they are needed [0] 

• To be able to organise them 
in a routine way in a 
structured environment (3) 

• To be able to organise 
information, data and 
content in a structured 
environment (4) 

• Structures and classifies information 
and content according to a standard 
classification scheme/method  

• Organize folders to use them as file 
repositories  

 
A.22 Your wonderful recipe of ‘Lasagna ala 
Muerte’ is being created in the recipe builder. 
Your colleagues at the class should be able to 
access it by using the searching function as 
easy as possible.  

1. you create an email by choosing ‘New’ at the 
email client and write at a text describing the 
success of your recipe. You then choose send. 
[0] 

2. you need to give the name ‘Pasta-Lasagna’ to 
your recipe [3] 

3. You create tags in the recipe builder named 
“Lasagna” and “ala Muerte”. You also add the 
tag ‘Pasta’ which is already available [4] 

4. You add two ingredients named “hot sauce” and 
“Spicy carry” to the recipe using the ‘Add 
ingredients’ function [0] 

5. you need to characterize the content with 
keywords so that other can find it easily  [2] 

6. you need help from the tutor on how to make 
your recipe known to your colleagues [1] 

• Uses various classification schemes to 
store and manage resources and 
information 

• Tag content 

 

Min Score for certifying this Competence: 0 points. Max Score for certifying this Competence: 28 points. 

Score mapping to level certification: 

Score range PL Result 

0-10 1-Basic   

11-17 2-Basic   

18-24 3-Intermediate   

25-28 4-Intermediate   
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Competence 2: Interaction through technologies 

 

3.4.4 Interacting through digital technologies (2.1)  

Descriptors (DIGCOMP) Skills Related Questions Answers [Score]  

• To be able to select simple 
digital technologies to 
interact (1&2) 

 

• Can distinguish between synchronous 
an asynchronous communication 
media and choose between them the 
most appropriate to the 
communication I want exchange. 

• Is aware of different digital 
communication means (e.g. email, 
chat, VoIP, video-conference, SMS)  

• Knows how messages and emails are 
stored and displayed 

• Understands the services offered by 
social media tools  

• Understands privacy and safety risks 
associated with the use of digital 
content 

• Able to find relevant communities, 
networks, and social media that 
correspond to his/her interests and 
needs 

A.23 You have met a group of people that 
share the same passion as you for cooking but 
it is difficult to meet them face-to-face to 
exchange recipes and cooking tips. You… 
 

1. chat with them on line with the help of a friend 
[1] 

2. exchange recipes by email [1] 
3. chat about cooking tips in Facebook [2] 
4. make Skype call to each of one of them 

separately [3] 
5. organize regular Skype group meetings [4] 
6. call them on the cell from time to time and talk 

about the recipes [0] 
 

A.24 Your are trying to set-up regular 
meetings with your on-line cooking group of 
friends. How do you organize these meetings?  

1. I call every member of the group and ask 
him/her about his/her availability [0] 

2. I organise their addresses in a contact list and I 
group-email them the details [2] 

3. I use a doodle with possible meeting dates for 
the meetings [3] 

4.  I set up a group in my email app and set-up 
automatic reminders for the meeting at the 
calendar [4] 

5. I email each one with the details of the meeting 
but i need help to contact all of them [1] 

6. I access the recipe builder and post a message at 
the forum [0] 
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• To be able to identify 
appropriate simple 
communication means for a 
given context. (1&2) 

• select well-defined and 
routine appropriate digital 
communication means for a 
given context (3) 

• select a variety of appro-
priate digital communication 
means for a given context (4) 

 

• Is able to send an email, write a blog 
post 

• Is able to use a chat or a discussion 
forum to communicate with others 

• Is able to receive and make on-line 
calls and video calls over the Internet  

• I can send and receive e-mails (send, 
reply, forward)  

• Understand and use a code of contact 

• Understand the importance of the 
virtual intentity and manage its 
properties 

• Able to identify privacy protection 
risks and apply measures 

• Manage conflicts that may occur 
among members in social media, 
networks and online communities  

• Able to moderate community content 
in social media 

• Select and use different tools for 
communicating depending on the 
purpose of the communication 

A.25 A friend of yours from the ‘Cooking 
Lessons School for Amateurs’ enrolled you to 
several social media groups about cooking. 
When interacting with people you don't know 
on these groups…:  

 

 

 

 

 
1. I use the “codes of good conduct” that are 

accepted on the Internet [3] 
2. I try to interact online in a respectful manner 

and sometimes I take advice from friends on 
how to behave on-line [2] 

3. I check my messages before sending them in 
order to ensure that they contain no spelling 
errors [0] 

4. I keep up to date with ethical practices in terms 
of internet use [4] 

5. I want to have an on-line presence but I need 
help to understand how to act when using social 
media apps [1] 

6. I stay silent and have no worries whatsoever [0] 

A.26 You are excited that your recipes are 
getting many positive comments and likes in 
the social groups you are participating. As you 
are getting more attention on-line, you think 
that the “virtual identity” that you adopt 
when publishing online: 

1. should give as much of your personal 
information to others as possible [0] 

2. should be configured  so as to give modest 
information and you need the help of a friend to 
do that [1] 

3. should be configured and you can change basic 
information such as the name and the avatar 
you use [2] 

4. should be configured and you can change basic 
and advanced information of your profile [3] 

5. should be managed so as to have different 
digital identities, depending on the purpose of 
the context [4] 

6. should be made public as much as possible so 
you start sending emails to your contacts [0] 
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• perform well-defined and 
routine interactions with 
digital technologies (3) 

• select a variety of digital 
technologies to interact (4) 

 

• Start a new online community 
Start a new online discussion 

• Start a new online blog 

• Organise and moderate on-line 
events 

• select appropriate application from a 
list of options depending on particular 
needs 

• select appropriate functions from a 
list of options of an application 
depending on particular needs 

• configure application 

A.27 Your knowledge on health food has 
increased and you want to communicate your 
findings to friends and other people like you. 
You can…: 

1. start sending emails to all the people you know 
about what you have learned and urge them to 
learn to cook for themselves [0] 

2. start a Facebook account about cooking and 
start inviting friends by email, or people from 
cooking forums and blogs [4] 

3. locate a forum about cooking and start new 
discussions with subjects relating to your 
findings [3] 

4. create interest in your work by contacting the 
people you know with the help of a friend who 
knows about on-line communication [1] 

5. start posting comments on cooking forums and 
blogs on your own and populate your address 
book with people  with similar interests as 
yourself [2] 

6. post a forum on the social function of the recipe 
builder [0] 

 

Min Score for certifying this Competence: 0 points.  Max Score for certifying this Competence: 20 points. 

Score mapping to level certification: 

Score range PL Result 

0-7 1-Basic   

8-12 2-Basic   

13-17 3-Intermediate   

18-20 4-Intermediate   



3.4.5 Engaging in citizenship through digital technologies (2.3)  

 

Descriptors (DIGCOMP) Skills Related Questions Answers [Score]  

• To be able to identify simple 
digital services in order to 
participate in society. (1&2) 

• To be able to select well-
defined and routine digital 
services in order to 
participate in society (3) 

• To be able to select digital 
services in order to 
participate in society.(4) 

 
 

• find and access the websites National 
and European Food Safety 
organizations, boards and NGOs 

• access a number of relevant networks 
and communities for different 
purposes  

• find relevant communities, networks, 
and social media that correspond to 
specific interests and needs 

• Select an on-line web based service 
that empowers citizenship 

• Select an on-line social medium that 
empowers citizenship 

 

A.28 You are becoming interested on the 
benefits of organic food and how they 
improve the health of middle-aged citizens.  
 

1. you email your friends and talk about the 
subject regularly [0] 

2. you need to search for National bodies or 
associations that are relevant to the subjects 
and subscribe to their newsletter and forums [2] 

3. you search on Twitter and Facebook for 
campaigns that promote organic food and 
follow them [3] 

4. you need to search on Google and Bing to find 
information on people, NGOs and associations 
that promote the use of organic food [1] 

5. you search for apps that promote participation 
and discussion of organic food issues anywhere 
at anytime using your mobile phone [4] 

6. you access the recipe builder and search for 
organic food recipes [0] 

 

A.29 You uploaded your organic food recipe 
onto the recipe builder. It is a traditional 
recipe of your home region, which is well 
known for its use of organic ingredients. You 
are eager to provide more details about the 
history of the region so that people that 
access your recipe will become acquainted 
with your culture and language. 

1. You start a discussion in the forum of the recipe 
builder providing a link to the recipe and links to 
the most famous landmarks of your region [0] 

2. You need help from the tutorial of the recipe 
builder to find out which function to use [1] 

3. You create a video for the history of your region 
and upload it to the History area of the recipe 
[4] 

4. You need to upload additional information [2] 
5. You create a video for the history of your region 

and use the recipe builder to post it[3] 
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• To be able to recognise sim-
ple appropriate digital 
technologies to empower 
myself and to participate in 
society as a citizen (1&2) 

• To be able to indicate well-
defined and routine 
appropriate digital 
technologies to empower 
myself and to participate in 
society as a citizen (3) 

• To be able to discuss 
appropriate digital 
technologies to empower 
myself and to participate in 
society as a citizen (4) 

• set up online accounts for 
private/public services 

• set up online accounts for 
private/public services, if that is 
requested to use the services 

• fill-in online forms with personal data 

• post an opinion for a review site 

• send a complaint or other feedback to 
a service provider 

• Inform other people about on-line 
campaigns and events 

A.30 You become more and more concerned 
about the shortcomings of synthetic crops and 
you want to participate and change things, if 
you can. What do you do? 

 

 

1. You need to send emails to all the policy makers 
of your region with the help of a friend[1] 

2. You open accounts to eDemocracy platforms 
provided by the Government and you post your 
opinion on the matter [3] 

3. You access the recipe builder and start a 
discussion on the forum concerning synesthetic 
crops [0] 

4. You need to fill-in an on-line form that is 
required for signing-in a Facebook account 
about health food and crops [2] 

5. You download and use apps that promote 
eCitizenship in real time, everywhere and at 
anytime and you inform you friends how to 
participate as well [4] 

6. You search in Google and Bing for more 
information on the subject using keywords such 
as ‘food’ and ‘synthetic’ [0] 

A.31 Your colleagues at the cooking class ask 
you to inform them about the possibilities 
simple people like them have to change 
regional and national health food policies 
through registration to eCitizenship platforms. 

1. You tell them they need to ask an expert on 
how to register to eCitizenship platforms[1] 

2. You advise them to [4] 
3. You need to search in Google on how to fill-

in on-line registration  forms[2] 
4. You will access the iMaker app and register 

as a protester [0] 
5. You will download the iWhatsUp app and 

enroll in discussion channels that relate to 
health and food [0] 

6. You register in a eCitizenship platform 
yourself and tell your friends to read the 
instructions [3] 
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A32. You want to set-up an online account in a 
social media app to represent a group of 
concerned citizens. Your goal is to increase 
awareness on health food and non-synthetic 
ingredients by posting information and engage 
in discussion with web users. You: 

 

1. start a Facebook campaign by selecting one 
of the marketing plans Facebook offers [0] 

2. You search for the suitable blog hosting 
service [3] 

3. You sign in to Wordpress and start a blog 
[4] 

4. You use word-of-mouth, or buzz marketing 
on Viber [0] 

5. You need to take advice from on-line 
articles before you make a decision [1] 

6. You need to select a medium that is suitable 
for both posting information and group 
discussion [2] 

 

Min Score for certifying this Competence: 0 points.  Max Score for certifying this Competence: 20 points. 

Score range PL Result 

0-7 1-Basic   

8-12 2-Basic   

13-17 3-Intermediate   

18-20 4-Intermediate   
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Competence 3: Content creation 

 

3.4.6 Developing digital content (3.1) 

Descriptors (DIGCOMP) Skills Related Questions Answers [Score]  

 

• To be able to identify ways to 
create and edit simple 
content in simple formats 
(1&2) 

• To be able to indicate ways 
to create and edit well-
defined and routine content 
in well-defined and routine 
formats (3) 

• To be ably to indicate ways 
to create and edit content in 
different formats (4) 

• Identify basic categories of software 
content management applications 

• Identify basic editing functions of text 
(copy, cut, paste, clear, select, find) 

• Identify basic editing functions of 
audio (copy, cut, paste, clear, select) 

• Identify basic editing functions of 
images (copy, cut, paste, clear, select) 

• Identify basic editing functions of 
video (copy, cut, paste, clear, select) 

• apply basic operations (new file, type, 
save) for text creation 

• apply basic create operations (record, 
save) for audio creation 

• apply basic operations (record, save) 
for video creation 

• apply basic operations (record, draw, 
save) for image creation 

• create text files in  in different 
formats (Word, txt) 

• create audio files in  in different 
formats (mp3, au) 

• create video files in  in different 
formats (mp4, avi) 

• create image files in  in different 
formats (jpg, gif) 

• Edit (copy, cut, paste, clear, select) 
text files 

• Edit (copy, cut, paste, clear, select) 
audio files 

A.33 You are ready to create the digital story 
that will give digital life to your cooking 
experience alive. But wait! You need tools and 
apps to create pictures the ingredients and the 
various stages of the creation of the dish. The 
setting is somewhat dark. 

1. You will create pictures using the web browser 
and the screen of your tablet [0] 

2. You need to use the camera app of the tablet on 
your own with possible some help of the tutor 
to adjust the zoom [2] 

3. You will use the camera app of you smart phone 
and adjust the flash and resolution [4] 

4. You will take the picture using the DSLR camera 
of your friend [0] 

5. With the help of the tutor you will take 
snapshots using the camera of the tablet [1] 

6. You will use an image capture or camera app to 
take the picture[3] 

A.34 You took some nice pictures but some 
parts of the execution of the recipe need to be 
explained in more detail. You decide to record 
3 minutes of video to explain how to cook 
them oysters. You need: 
 
 

1. A tablet and the iDirector app to stage the scene 
[0] 

2. A tablet and a friend to record your actions [2] 
3. A tablet, a projector (with a 15pin cable) and the 

Internet Explorer app [0] 
4. The help of the tutor to decide what kind of 

equipment is need [2] 
5. A smartphone with a camera [3] 
6. A tablet, the iMovie app and a friend to hold the 

tablet [4] 

A.35 A friend of yours asks if you can advice 
him in which format to save a 15 minutes 
video he just recorded while preparing the 
ingredients of his soup. You advice him to: 
 

1. better to ask the tutor [1] 
2. need to be saved in the proper format because 

of its size [2] 
3. save it in mp4 format [4] 
4. save it in mp3 format [0] 
5. save it in avi format [3] 
6. save it in jpeg format with the help of a tutor [0] 
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• Edit (copy, cut, paste, clear, select) 
video files 

• Edit (copy, cut, paste, clear, select) 
image files 

• Upload content onto on-line 
platforms and repositories 

• configure the app that creates the 
content so as to achieve the best 
quality in relation to the setting 

• choose the right format (to save my 
files) for the indented purpose 

• manipulate size of output file during 
content creation by configuring the 
content attributes 

 

 

A.36 To edit and copy your text in Word you 
select the text to copy. A friend interrupts you 
and asks urgently your help to do the same 
think (he has not saved his text and he is 
afraid of losing it). You 
 
 

1. push CTRL-C and then CTRL-V and you tell your 
friend to do the same[4] 

2. need to ask your tutor about it and you tell your 
friend to do the same[1] 

3. open the Edit menu and select Copy and then 
Paste and you tell your friend to ask the tutor 
[3] 

4. need to go the Edit menu and select an option 
with the help of the tutor. I tell my friend to do 
the same [2] 

5. open the File menu and select CTRL-X then 
CTRL-Enter and you tell your friend to do the 
same. [0] 

6. need to go the File menu and select an option 
with the help of the tutor. I tell my friend to do 
the same [0] 

A.37 To edit and copy a part of a video, sound 
or image in the app you are using, you: 
 

1. watch a tutorial on YouTube on how to select it 
[1] 

2. select an area or a timeline and find the 
appropriate functions in the Edit menu[3] 

3. select a timeline for the video/sound or an area 
for the image and  [4] 

4. first select an area or a timeline and find the 
appropriate functions in the File menu[0] 

5. need to go the Edit menu and select an option 
with the help of the tutor [2] 

6. need to go the File menu and select an option 
with the help of the tutor [0] 
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A.38 You are ready to create you first recipe 
using the recipe builder. You log-in to the 
platform and: 
 

1. you choose “File” from the menu and then you 
choose the ‘New’ button [0] 

2. you need to push the New button from the 
ribbon [2] 

3. you need help from the tutor to continue [1] 
4. you push the New button from the ribbon[3] 
5. you push the ‘New’ button from the menu and 

enter a new name for the recipe [0] 
6. you push the ‘New’ button from the ribbon and 

enter a new name for the recipe[4] 

• To be able to choose how I 
express myself through the 
creation of simple digital 
means (1&2) 

• To be able to express myself 
through the creation of well-
defined and routine digital 
means (3) 

• To be able to express myself 
through the creation of 
digital means (4) 

• upload content onto online platforms 
depending on its format and size  

• choose apps that suit my purpose by 
identifying the capabilities and 
services offered by them 

• choose apps that suit my purpose by 
identifying which apps can be used to 
produce each content format 

• create an efficient content 
development task plan by choosing 
from a list of available tools and 
devices 

• choose devices that express in other 
forms my creation 

• use apps for content creation that 
suits my purpose by identifying the 
capabilities and services offered by 
them 

• use devices that express my creation 
in other means 

• use apps for content creation that 
suits my purpose by identifying the 
capabilities and services offered by 
them 

• use devices that enchase my creation 

A.39 To upload a video onto the LinguaCuisine 
recipe builder you: 
 

1. need to read the instructions of the recipe 
builder first [1] 

2. log-in and go to the recipe methods of a recipe 
you loaded [3] 

3. need to log-in and go to the recipe ingredients 
[0] 

4. need to log-in to the recipe builder and load a 
recipe [2] 

5. log-in to the recipe builder and add an 
ingredient to the recipe [0] 

6. log-in to the recipe builder and add a step to a 
method of a recipe you loaded[4] 

7. log-in to the recipe builder and add a method to 
the step of a recipe[0] 

 

A.40 Your recipe is loaded onto the builder. It 
is time to add a pallete knife you used details. 
To upload the image onto the recipe builder: 
 

1. you need help from the tutor [1] 
2. you need to configure the view of the recipe [2] 
3. you select ‘Movie View’ and add an utensil [3] 
4. you select either ‘Movie’ or ‘List’ view and add 

an utensil using the Plus icon[4] 
5. you select the ‘Player’ view and add an utensil 

using the ‘Add’ button [0] 
6. you select the folder icon in the main screen and 

select a picture to upload from the dialog box 
that appears  [0] 
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in other means A.41 The pallete knife image has been 
uploaded. It looks great. Now you need to 
explain in brief how this utensil is used. You 
record a 1minute of audio and store it to a file 
in your device. To upload it to the recipe 
builder you: 
 

1. load the recipe, access the utensils in the ‘List’ 
mode, find and open the pallete knife utensil, 
edit it and add the audio using the folder button 
[4] 

2. load the recipe, go to Player mode and load the 
audio using the ‘Load’ button [0] 

3. need to upload the file somehow but you need 
help from the tutor to do it [1] 

4. need to access the utensils of the recipe and 
find the specific utensil [2] 

5. need to load the recipe and find the pallete 
knife and edit it [3] 

6. need to load the recipe and access the utensils 
in ‘Text’ view mode, then load the file [0] 

 

Min Score for certifying this Competence: 0 points. Max Score for certifying this Competence: 36 points. 

Score range PL Result 

0-13 1-Basic   

14-22 2-Basic   

23-31 3-Intermediate   

32- 36 4-Intermediate   



APPENDIX I TEST I- TRAINEE EVALUATION TEST 
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                                   linguacuisine.com 

 

This test is used to evaluate the basic digital competences (Proficiency Levels 1-4) of trainees for the following 
Competence Areas of DIGCOMP v2.1:  

1. Information and data literacy 
1.1 Browsing, searching and filtering data, information and digital content 
1.2 Evaluating data, information and digital content  
1.3 Managing data, information and digital content  

2. Communication and collaboration 

2.1 Interacting through digital technologies 

2.3 Engaging in citizenship through digital technologies 

3. Digital content creation 

3.1 Developing content  

 

For each Competence, a number of questions have been prepared.  

The total number of questions is 40. The questions have been grouped into 6 different groups, one for each 
Competence of DIGCOMP. Only one (1) answer from the available options must be selected. 

 

In order to complete the test, read carefully the description of each situation and picture yourself in it. Mark the 
answer by circling the number on the left of it. Total time allowed is 45 minutes. 

 

 

 

Name of trainee:  

…………………………………………………………………………………………………………………….. 

 

Name of tutor:  

……………………………………………………………………………………………………………………….. 

 

 

Date: …………………………… Location: ………………………………………………………………………. 
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A.1. To start an online search, the first thing you need to do is to open an app. Which one? 

 I need help from an expert to understand what to open 
 Internet Explorer or Mozilla  
 I choose any web browsers for all kind of needs  
 Internet Explorer  
 I choose a web browser that is supported in my platform  
 Facebook or Twitter  
 
 
Α.2. You need to select a specific search engine in your tablet. Which application allows you to gain 
access to the World Wide Web? 
 Firefox or Internet Explorer  
 Google  
 Google or Yahoo!  
 There are many search engines to choose from such Google, Bing, AOL etc.  
 Depending on the type of information I looking for I choose different search engines  
 
 
Α.3 You want to search for Italian recipes for pasta with sauce. Which keywords are you going to 
use?  
 I need to use the “Pasta” keyword  
 “Pasta” AND   “Italian Recipes”  
 “Pasta” AND “Italian Recipes” AND “sauce”  
  I need help to decide  
 I access a web page directly by typing a web address  
 
 
A.4. You find many websites that contain information about Italian recipes for pasta. You want to 
visit the first 5 results of the search. 
 I navigate among the pages (backwards, forward) by myself  
 I navigate a website's pages through hyperlinks  
 The buttons of the browser (forward, back) are used for navigating in lists  
 I navigate a website's pages through text, image hyperlinks and menus  
 I need help to navigate among the pages  
 The green letters are used for navigating to a result  
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A.5 You want to find videos that display the execution of a recipe for a Greek salad. A friend 
presents to you a relevant video collection with 50 videos, from YouTube. You: 
 think it is easier to Skype a Greek person and ask how to make the salad 
 ask a web technician to help you install the software needed to watch the videos  
 navigate through the videos using the collection panel buttons  
 watch all the videos in the collection one after the other until you reach the one that really 

interests you  
 inspect the videos and refine the search to get more accurate results  
 
 
A.6 I want to access the recipe builder functions. I open a browser and access the web address of 
the builder.  Then: 
 I use my Google account to log-in and access the functions  
 I use my Facebook account to log-in and access the functions  
 I need help from the tutor to access the builder  
 I use an existing account to log-in 
 I need to login to access the functions  
 No login information is needed, the service is free  

 
 

A.7 Having logged-in to the Recipe Builder I want to navigate through the resources and structure. 
 I navigate using the Back and Forward buttons of the browser  
 I need to use the proper buttons with the symbols  
 I navigate using the buttons on the ribbons of the builder in the top of the screen  
 I navigate using the buttons on the ribbons of the builder in the top, middle and bottom of the 

screen  
 I navigate using the menu of the builder and in the top of the screen  
 I ask my tutor to help me how to navigate  

 
 

A.8 You perform a search for finding the ingredients of ‘Pasta Flora’ and you end up with results 
describing the flora of the Sahara desert. What do you do? 
 I use another search engine and do the same search  
 I expand the keywords I used for searching to include the keyword ‘recipe’  
 I do the search again with the help of an expert  
 I restart the browser to erase the search memory  
 Navigate to the results and try to find the recipe  
 I remember the keywords I used in previous searches with good results and adjust the search 

terms. 
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A.9 You are finalizing the list of ingredients that you want to use in your recipe. You need to search 
for tomato sauce pictures, your last ingredient. You also need utensils’ photos. 
 You can search for ingredient pictures in the recipe builder  
 You need help from a tutor to decide  
 The recipe builder does not contain any utensils repository  
 You search for ingredient pictures and utensils in the recipe builder using keywords  
 You search for ingredient pictures in the recipe builder using a keyword  
 You search for ingredient pictures in the recipe builder using the tags in the pull down menu  
 
 
A.10 You are reading an article on a blog stating that consuming meat is dangerous. How could you 
assess the credibility of the content of this article? 
 With the help of an expert I shall check the author’s information  
 I shall check when the article was written and how often is the site updated  
 I shall check when the article was written and if the author is famous  
 It is not necessary to assess the content of this article because information on the internet is often 

credible  
 I shall search on Google to verify the basic facts of the article  
  I shall search in at least two search engines and medical sites using as keywords the title of the 

article, to verify the facts of the article  
 
 
A.11 A friend recommends an article on a blog on how to prepare vegetarian meals. You evaluate 
the credibility of the article by: 
 the sponsors of the blog  
 the precision of the language used to describe the recipes  
 the number of users commenting the article  
 the ratings for the article as they are provided by the users 
 the number and quality of advertisements in the site  
 
 
A.12 An email advertisement prompts you to follow a ‘Healthy Recipes’ account on Facebook. You 
want to check its credibility so you: 
 check the number of users following the account  
 read the user comments on the first 3 recipes and if they are positive you continue to read more 

till you are convinced  
 cross-check the content of the recipes with results you found on the subject from other sources 

like Google and YouTube  
 need help to decide if the posts are credible  
 execute the more recent recipe posted and invite your boss for dinner  
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A.13 You want to learn to cook using authentic German recipes for stew. Some of the resources you 
find are written in German, others are written in English. How are you going to find out, which are 
appropriate?   
 You become member in forums and Facebook groups that publish information that you are 

interested in to use and ask for advice  
 You ask a friend that speaks German to help you  
 You search for ‘German cooking’ in Google and then refine the results using subject related 

keywords.  
 You use automatic translation to evaluate what is appropriate in your case  
 You try to understand what the recipes mean by looking at the accompanying pictures  
 
 
 
A.14 You show a television show hosting a famous cook and you want to learn more about him and 
his accomplishments. You are eager to talk about what you learned in the cooking lesson next 
week. What do you do? 
 You read the relevant Wikipedia article   
 You Google his name but you need help from a friend to select what to read  
 You join a forum and ask the other users about him  
 You search for articles in electronic newspapers, magazines and official cooking sites  
 You email him and ask for more information  
  You search in Google, Facebook and Cooking blogs to discover what people are saying about him  
 
 
 
A.15 You are using the search function of the recipe builder to find information and pictures of 
healthy ingredients other people have uploaded onto the app. You enter the search terms ‘healthy’ 
and a list of 5 results appears. In which characteristics of each result do you pay attention in order 
to decide if it is the one you are looking for? 
 I need help from a tutor to decide how to assess the quality of the results  
 I examine the video of the ingredient in order to decide  
 I look at the title of each result, I examine the image and listen to the audio describing the 

ingredient.  
 I look at the title of each results and the image describing the ingredient 
 I look at the title of each result, the image and read carefully the comments made by users to 

decide  
 I need to look at characteristics that describe the ingredient  
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A.16 How can you save a blog about Salad recipes in your desktop and then view it offline? 
 I need help to save this information  
 I click on Menu -> File-> Save as…  
 I write down the address of the blog and then type it every time I go online  
 I bookmark the web address of the blog  
 I save the blog address in my favourites and organize it later in my bookmarks  
 
A.17 At last you found the ideal appearance of a green salad in an image that appears in a cooking 
web site.  How can you save it in order to upload it later to the recipe builder?  

 You click ‘Print’ from the menu in order to make it a poster in your room  
 You left click on the image until it downloads completely  
 I need help form an expert to do that!  
 I ‘ll probably use a Save function but I will ask for help from a friend on how to do that  
 I will right click and save the image on my desktop  
 I will right click and save the image on a folder named “Favorite Recipe Images”  

 
 
A.18 After a tedious search, at last you have found a lot of information on Thai food. This includes 
text and images from Google and videos from YouTube. How are you going to store the videos? 
 I shall ask my friend to help decide where to store them  
 I ‘ll probably save them in my desktop after I ask a friend of mine who is a computer expert  
 I shall use the ‘Save as…’ command to store the videos to my flash disk  
 I shall store the web addresses of the videos to my electronic notes  
 I shall add the addresses as bookmarks to my Recipe Video bookmarks  
 
 
A.19 A friend of yours asks you to give him all the data concerning recipes you have stored and 
organized in folders, in your computer this year. You: 
 need his help to transfer the files  
 shall probably copy them one by one to disk after you ask a computer expert  
 shall use the ‘Save as…’ command to store the videos to my flash disk  
 shall copy and paste the data folders to a flash drive  
 shall make them temporarily available in your iCloud account for him to download  
 shall connect a cable to your computer and transfer the data  
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A.20 You return to the course after a break and you continue to design your recipe of ‘Hot Spice 
Lasagna’ on the LinguaCuisine builder. Your tablet has restarted.  You need continue what you have 
done before the break, so you access the builder and: 
 you need to load the recipe and you may need help from a friend to do that  
 you need to get help from a friend that has already used the builder more times than yourself  
 you choose ‘Load’ from the File menu and the enter the name of the ingredient Hot Spice  
 you choose ‘Load’ from the File menu and the enter the name of the ingredient Hot Spice  
 you press the ‘Load’ button from the ribbon  
 you press the ‘Load’ button from the ribbon and then tick the field ‘Completed recipes only’  
 you press the ‘Load’ button from the ribbon and then select the name of the recipe from the 

available recipes 
 
 
A.21 You have week to create 3 digital stories on how to cook baked lasagna, lasagna ala Muerte 
and lasagna Napolitana. You will need text, audio files, images and video for each recipe or 
ingredient to create the stories and you need to organize the content before you upload it to the 
recipe builder. You:  
 ask the help of a friend to advice you how to organize the files  
 shall probably organize the files by ingredient after you ask a computer expert  
 shall store everything on the desktop for easy access  
 shall create folders and sub-folders per ingredient and then organize the files by type  
 shall decide first on the naming principles of the structure you are going to use and then store the 

files in subfolders according to the recipe, ingredient and file type  
 shall download the files from the Web when they are needed  
 
 
A.22 Your wonderful recipe of ‘Lasagna ala Muerte’ is being created in the recipe builder. Your 
colleagues at the class should be able to access it by using the searching function as easy as 
possible. 
 you create an email by choosing ‘New’ at the email client and write at a text describing the 

success of your recipe. You then choose send.  
 you need to give the name ‘Pasta-Lasagna’ to you recipe  
 You create tags in the recipe builder named “Lasagna” and “ala Muerte”. You also add the ta 

‘Pasta’ which is already available  
 You add two ingredients named “hot sauce” and “Spicy carry” to the recipe using the ‘Add 

ingredients’ function  
 you need to characterize the content with keywords so that other can find it easily   
 you need help from the tutor on how to make your recipe known to your colleagues  
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A.23 You have met a group of people that share the same passion as you for cooking but it is 
difficult to meet them face-to-face to exchange recipes and cooking tips. You… 
 chat with them on line with the help of a friend  
 exchange recipes by email  
 chat about cooking tips in Facebook  
 make Skype call to each of one of them separately  
 organize regular Skype group meetings  
 call them on the cell from time to time and talk about the recipes  
 
 
 
A.24 Your are trying to set-up regular meetings with your on-line cooking group of friends. How do 
you organize these meetings? 
 I call every member of the group and ask him/her about his/her availability  
 I organise their addresses in a contact list and I group-email them the details  
 I use a doodle with possible meeting dates for the meetings  
  I set up a group in my email app and set-up automatic reminders for the meeting at the calendar  
 I email each one with the details of the meeting but i need help to contact all of them  
 I accces the recipe builder and post a message at the forum  
 
 
 
A.25 A friend of yours from the ‘Cooking Lessons School for Amateurs’ enrolled you to several social 
media groups about cooking. When interacting with people you don't know on these groups…:  
 I use the “codes of good conduct” that are accepted on the Internet  
 I try to interact online in a respectful manner and sometimes I take advice from friends on how to 

behave on-line  
 I check my messages before sending them in order to ensure that they contain no spelling errors  
 I keep up to date with ethical practices in terms of internet use  
 I want to have an on-line presence but I need help to understand how to act when using social 

media apps  
 I stay silent and have no worries whatsoever  
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A.26 You are excited that your recipes are getting many positive comments and likes in the social 
groups you are participating. As you are getting more attention on-line, you think that the “virtual 
identity” that you adopt when publishing online: 
 should give as much of your personal information to others as possible  
 should be configured  so as to give modest information and you need the help of a friend to do 

that  
 should be configured and you can change basic information such as the name and the avatar 

you use  
 should be configured and you can change basic and advanced information of your profile  
 should be managed so as to have different digital identities, depending on the purpose of the 

context  
 should be made public as much as possible so you start sending emails to your contacts  
 
 
A.27 Your knowledge on health food has increased and you want to communicate your findings to 
friends and other people like you. You can…: 
 start sending emails to all the people you know about what you have learned and urge them to 

learn to cook for themselves  
 start a Facebook account about cooking and start inviting friends by email, or people from cooking 

forums and blogs  
 locate a forum about cooking and start new discussions with subjects relating to your findings  
 create interest in your work by contacting the people you know with the help of a friend who 

knows about on-line communication  
 start posting comments on cooking forums and blogs on your own and populate your address 

book with people  with similar interests as yourself  
 post a forum on the social function of the recipe builder  

 
 

A.28 You are becoming interested on the benefits of organic food and how they improve the health 
of middle-aged citizens.  
 you email your friends and talk about the subject regularly  
 you need to search for National bodies or associations that are relevant to the subjects and 

subscribe to their newsletter and forums  
 you search on Twitter and Facebook for campaigns that promote organic food and follow them  
 you need to search on Google and Bing to find information on people, NGOs and associations that 

promote the use of organic food  
 you search for apps that promote participation and discussion of organic food issues anywhere at 

anytime using your mobile phone  
 you access the recipe builder and search for organic food recipes  
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A.29 You uploaded your organic food recipe onto the recipe builder. It is a traditional recipe of your 
home region, which is well known for its use of organic ingredients. You are eager to provide more 
details about the history of the region so that people that access your recipe will become 
acquainted with your culture and language. 
 You need to send emails to all the policy makers of your region with the help of a friend 
 You open accounts to eDemocracy platforms provided by the Government and you post your 

opinion on the matter  
 You access the recipe builder and start a discussion on the forum concerning synesthetic crops  
 You need to fill-in an on-line form that is required for signing-in a Facebook account about health 

food and crops  
 You download and use apps that promote eCitizenship in real time, everywhere and at anytime 

and you inform you friends how to participate as well  
You search in Google and Bing for more information on the subject using keywords such as ‘food’ 
and ‘synthetic’  

 
A.30 You become more and more concerned about the shortcomings of synthetic crops and you 
want to participate and change things, if you can. What do you do? 
 You need to send emails to all the policy makers of your region with the help of a friend 
 You open accounts to eDemocracy platforms provided by the Government and you post your 

opinion on the matter  
 You access the recipe builder and start a discussion on the forum concerning synesthetic crops  
 You need to fill-in an on-line form that is required for signing-in a Facebook account about health 

food and crops  
 You download and use apps that promote eCitizenship in real time, everywhere and at anytime 

and you inform you friends how to participate as well  
 You search in Google and Bing for more information on the subject using keywords such as ‘food’ 

and ‘synthetic’  
 

A.31 Your colleagues at the cooking class ask you to inform them about the possibilities simple 
people like them have to change regional and national health food policies through registration to 
eCitizenship platforms. 
 You tell them they need to ask an expert on how to register to eCitizenship platforms 
 You advise them to  
 You need to search in Google on how to fill-in on-line registration  forms 
 You will access the iMaker app and register as a protester  
 You will download the iWhatsUp app and enroll in discussion channels that relate to health and 

food  
 You register in a eCitizenship platform yourself and tell your friends to read the instructions  
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A32. You want to set-up an online account in a social media app to represent a group of concerned 
citizens. Your goal is to increase awareness on health food and non-synthetic ingredients by posting 
information and engage in discussion with web users. You: 
 start a Facebook campaign by selecting one of the marketing plans Facebook offers  
 You search for the suitable blog hosting service  
 You sign in to Wordpress and start a blog  
 You use word-of-mouth, or buzz marketing on Viber  
 You need to take advice from on-line articles before you make a decision  
 You need to select a medium that is suitable for both posting information and group discussion  
 
 
 
A.33 You are ready to create the digital story that will give digital life to your cooking experience 
alive. But wait! You need tools and apps to create pictures the ingredients and the various stages of 
the creation of the dish. The setting is somewhat dark. 
 You will create pictures using the web browser and the screen of your tablet  
 You need to use the camera app of the tablet on your own with possible some help of the tutor to 

adjust the zoom  
 You will use the camera app of you smart phone and adjust the flash and resolution  
 You will take the picture using the DSLR camera of your friend  
 With the help of the tutor you will take snapshots using the camera of the tablet  
 You will use an image capture or camera app to take the picture 
 
 
 
A.34 You took some nice pictures but some parts of the execution of the recipe need to be 
explained in more detail. You decide to record 3 minutes of video to explain how to cook them 
oysters. You need: 
 A tablet and the iDirector app to stage the scene  
 A tablet and a friend to record your actions  
 A tablet, a projector (with a 15pin cable) and the Internet Explorer app  
 The help of the tutor to decide what kind of equipment is need  
 A smartphone with a camera  
 A tablet, the iMovie app and a friend to hold the tablet  
 
 
 
 
 
 
 
 
 



The LinguaCuisine Certification system 

 

78 

 

 
A.35 A friend of yours asks if you can advice him in which format to save a 15 minutes video he just 
recorded while preparing the ingredients of his soup. You advice him to: 
 better to ask the tutor  
 taste the soup first and the then decide if he wishes to save the video or re-shoot  
 save it in mp4 format  
 save it in mp3 format  
 save it in avi format  
 save it in jpeg format with the help of a tutor  
 
A.36 To edit and copy your text in Word you select the text to copy. A friend interrupts you and 
asks urgently your help to do the same think (he has not saved his text and his is afraid of losing it). 
You 
 push CTR-C and then CTRL-V and you tell your friend to do the same 
 need to ask your tutor about it and you tell your friend to do the same 
 open the Edit menu and select Copy and then Paste and you tell your friend to ask the tutor  
 need to go the Edit menu and select an option with the help of the tutor. I tell my friend to do the 

same  
 open the File menu and select CTRL-X then CTRL-Enter and you tell your friend to do the same.  
 need to go the File menu and select an option with the help of the tutor. I tell my friend to do the 

same  
 
 
A.37 To edit and copy a part of a video, sound or image in the app you are using, you: 
 watch a tutorial on YouTube on how to select it  
 select an area or a timeline and find the appropriate functions in the Edit menu 
 select a timeline for the video/sound or an area for the image and   
 first select an area or a timeline and find the appropriate functions in the File menu 
 need to go the Edit menu and select an option with the help of the tutor  
 need to go the File menu and select an option with the help of the tutor  
 
 
 
A.38 You are ready to create you first recipe using the recipe builder. You log-in to the platform 
and: 
 you choose “File” from the menu and then you choose the ‘New’ button  
 you need to push the New button from the ribbon  
 you need help from the tutor to continue  
 you push the New button from the ribbon 
 you push the ‘New’ button from the menu and enter a new name for the recipe  
 you push the ‘New’ button from the ribbon and enter a new name for the recipe 
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A.39 To upload a video onto the LinguaCuisine recipe builder you: 
 need to read the instructions of the recipe builder first  
 log-in and go to the recipe methods of a recipe you loaded  
 need to log-in and go to the recipe ingredients  
 need to log-in to the recipe builder and load a recipe  
 log-in to the recipe builder and add an ingredient to the recipe  
 log-in to the recipe builder and add a step to a method of a recipe you loaded 
 log-in to the recipe builder and add a method to the step of a recipe you loaded 

 
 

A.40 Your recipe is loaded onto the builder. It is time to add a pallete knife you used details. To 
upload the image onto the recipe builder you: 
 you need help from the tutor  
 you need to configure the view of the recipe  
 you select ‘Movie View’ and add an utensil  
 you select either ‘Movie’ or ‘List’ view and add an utensil using the Plus icon 
 you select the ‘Player’ view and add an utensil using the ‘Add’ button [ 
 you select the folder icon in the main screen and select a picture to upload from the dialog box 

that appears   
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linguacuisine.com 

 

This test is used to evaluate the basic digital competences (Proficiency Levels 1-4) of trainees for the following 
Competence Areas of DigComp v2.1:  

1. Information and data literacy 
1.1 Browsing, searching and filtering data, information and digital content 
1.2 Evaluating data, information and digital content  
1.3 Managing data, information and digital content  

2. Communication and collaboration 

2.1 Interacting through digital technologies 

2.3 Engaging in citizenship through digital technologies 

3. Digital content creation 

3.1 Developing content  

 

For each Competence, the trainee is asked to perform a sequence of actions. The trainer marks the ability of the 
trainee to complete the task and the degree of independence in carrying out the activities. 

For each Competence, a number of questions have been prepared.  

The total number of questions is 31. The questions have been grouped into 6 different groups, one for each 
Competence of DIGCOMP.  

Only one (1) answer from the available options must be selected. The points corresponding to each answer 
(denoted in parenthesis right below the answer) must be summed at the end of the group of questions. A table 
depicting the ranges corresponding to the certificate level of the trainee can be used to derive the result. 

 

Name of trainee:  

…………………………………………………………………………………………………………………….. 

 

Name of tutor:  

……………………………………………………………………………………………………………………….. 

 

 

Date: …………………………… Location: ………………………………………………………………………. 
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Scenario: Prepare an Italian meal for a special day 

 

Competence 1: Information and data literacy 

 

Competence 1.1: Browsing, searching and filtering data, information and digital content 

To articulate information needs, to search for data, information and content in digital 
environments, to access them and to navigate between them. To create and update personal 
search strategies. 

 

Task Search for different Italian wines  

B.1 Select a search engine 

Can do with 
assistance 

 

Knows one search 
engine 

 

Knows many search 
engines 

 

Uses text and video 
search engines 

 

    (1)      (2)     (3)      (4) 

        

 

B.2 Use correct keywords for searching 

Can do with 
assistance 

 

Uses 1 keyword 

 

Uses many keywords 

 

Performs different 
searches 

 

    (1)      (2)    (3)      (4) 

        

 

B.3 Visit the web site of three producers of wine from the result list 

Can do with 
assistance 

 

Basic navigation back 
and forth 

 

Navigate using 
hyperlinks besides 

basic ones 

 

Uses image and/or 
menu hyperlinks to 
navigate in the web 

sites 

   (1)      (2)    (3)    (4) 

        
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B.4 Update search to find pasta dishes and Italian wines 

Can do with 
assistance 

 

 

Uses 3 keywords or 
less 

 

 

Uses 4 keywords 

Pasta AND wine 

 

 

Uses AND operator 
with keywords 

Pasta dishes AND 
Italian wine 

 

   (1)      (2)    (3)      (4) 

        

 

B.5 Try to access the recipe builder 

Can do with 
assistance 

 

 

Uses keywords and 
search engine 

 

 

Uses Lingua Cuisine 
project web site 

 

 

Types the web adress 
to the browser 

 

  (1)      (2)    (3)    (4) 

        

 

B.6 Search for a sauce in the recipe builder 

Can do with 
assistance 

Understands where it 
generally is but needs 

help to locate it 

 

Can find the search 
function (can go to 

Detail or Movie view) 

 

 

Uses the search 
function 

 

   (1)   (2)    (3)      (4) 

        
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Score for Competence 1.1: Browsing, searching and filtering data, information and digital 
content:_____ out of 24 points 

 

Score range PL Result 

5-8 1-Basic   

9-14 2-Basic   

15-20 3-Intermediate   

21-24 4-Intermediate   
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Competence 1.2: Evaluating data, information and digital content 

To analyse, compare and critically evaluate the credibility and reliability of sources of data, 
information and digital content. To analyse, interpret and critically evaluate the data, 
information and digital content. 

 

B.7 Find read and evaluate the credibility of a review about Cabernet Sauvignon 

Can do with 
assistance 

 

Checks the website 
provider to evaluate 

credibility 

 

Consults at least 
another source of 

information 

 

Consults at least two 
other sources of 

information 

 

   (1)      (2)    (3)     (4) 

        

 

 

B.8 Find and read the recipe posted in a blog about pasta dishes and the wines that go with them.  Evaluate 
the credibility of the article 

Can do with 
assistance 

 

Checks the website 
provider to evaluate 

credibility 

 

Checks language and 
quality of appearance 

of blog 

 

Checks language, 
precision, detailed 

and critical analysis of 
recipe execution 

 

   (1)      (2)     (3)     (4) 

        

 

 

B.9 Find an article of a carrot soup recipe. Evaluate the quality of the recipe based on the comments. 

Can do with 
assistance 

 

Checks the number of 
the comments 

 

Checks the positive vs 
negative comments 

 

Cross-analyses the 
comments and is able 
to derive conclusion 

or derive that no 
conclusion can be 

produced 

 

   (1)      (2)     (3)      (4) 

        
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B.10 Evaluate information about a famous cook (e.g. Gordon Ramsey). Find information and evaluate basic 
facts about his cooking ability 

 

Can do with 
assistance 

 

Checks one source of 
information 

(e.g. Wikipedia) 

 

Checks at least 2 
authoritative sources 

 

Checks at least 2 
authoritative sources 
including articles in 
specialised cooking 

magazines/blogs 

    (1)      (2)    (3)    (4) 

        

 

B.11 Search and evaluate information in the recipe builder. Search for the knife utensil in the ingredient and 
evaluate the first 5 results. 

 

Can do with 
assistance 

 

Checks image 

 

Checks image and 
audio description of 

each one 

 

Checks image and 
audio description and 

compares 

 

    (1)      (2)    (3)      (4) 

        

 

 

 

Score for Competence 1.2: Evaluating data, information and digital content: 

_____ out of 20 points 

 

Score range PL Result 

5-7 1-Basic   

8-12 2-Basic   

13-17 3-Intermediate   

18-20 4-Intermediate   
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Competence 1.3: Managing data, information and digital content 

To organise, store and retrieve data, information and content in digital environments. To 
organise and process them in a structured environment. 

 

B.12 Search for a pasta dish. Visit one of the results and save recipe for later use. 

 

Can do with 
assistance 

 

Saves html to disk Saves url or 
bookmarks address 

 

Adds url to favourites 
or bookmarks web 

site or creates folder 
in which url is saved 

 

    (1)      (2)    (3)      (4) 

        

 

 

B.13 Search for seafood pasta dishes. Save the five results so you may easily access them later. 

 

Can do with 
assistance 

 

Saves html to disk Creates folder to save 
the files 

 

Bookmarks web pages 
and organises them in 

bookmark folder 

 

   (1)      (2)     (3)      (4) 

        

 

 

B.14 In the seafood pasta dishes, save the images of the first three results.  

 

Can do with 
assistance 

 

Saves to desktop Saves to folder 

 

Saves to folder and 
names the folder 

   (1)       (2)    (3)     (4) 

        
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B.15 Save and organize content (including video and audio). 

For seafood pasta, save/store three different recipes (text and at least an image for each one) including a 
video for each one. Organise your save policy so you can easily find them later. 

 

Can do with 
assistance 

 

Saves recipes in 3 
folders. 

Needs help to store 
video 

Saves recipes in 3 
main folders. Creates 

subdfolders for 
images and text. 

 

Uses folders and 
subfolders. Stores 
video url to disk or 

bookmarks. 

   (1)      (2)     (3)    (4) 

        

 

 

B.16 Open files stored in own device.  

 

Can do with 
assistance 

 

Saves to desktop Saves to folder 

 

Saves to folder and 
names the folder 

  (1)      (2)    (3)      (4) 

        

 

 

Score for Competence 1.3: Managing data, information and digital content 

_____ out of 20 points 

 

Score range PL Result 

5-7 1-Basic   

8-12 2-Basic   

13-17 3-Intermediate   

18-20 4-Intermediate   
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Competence 2: Interaction through technologies 

 

Competence 2.1: Interacting through digital technologies 

To interact through a variety of digital technologies and to understand appropriate digital 
communication means for a given context. 

 

B.17 Join apps for on-line interaction. Choose off-line and/or on-line apps. 

Join/enrol in an app to discuss your opinion about a famous cook TV show with your friends using your device.  

 

Can do with 
assistance 

 

Logs in or opens email 
account 

Joins off-line app 

(e.g. forum, blog, 
iChat) 

 

Joins real time com 
app 

(e.g. Skype, Viber) 

   (1)      (2)    (3)     (4) 

        

 

 

B.18 Make a basic contact (on line or off-line). 

Exchange opinions about the show with one of your friends using an app. 

 

Can do with 
assistance 

 

Sends email Uses off-line app, 
posts message 

(e.g. forum, blog, 
iChat) 

 

Uses real time com 
app 

(e.g. makes Skype 
call) 

   (1)       (2)    (3)      (4) 

        
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B.19 Organise your contacts. Make group communication. Choose appropriate app depending on the context. 

More friends join the conversation! Organise the communication of the group.  

 

Can do with 
assistance 

 

Group email 
addresses 

Open conversation in 
or group talk in off-

line app 

(e.g. forum 
conversation, iChat 
with more than 2 

participants) 

 

Real time group com 

 

(e.g. Skype call with 
more than 2 
participants) 

   (1)      (2)    (3)      (4) 

        

 

 

B.20 Be aware of on-line risks, code of conduct. 

Set up an on-line account in Google+ (or similar service) and join a cooking community. Configure personal 
settings. Post a message introducing yourself to the community and create some attention. 

 

Can do with 
assistance 

 

Provides some 
personnal 

information. 

Message is brief 

Provides very litte 
personnal 

information. Message 
is somewhat 
interesting. 

Provides only 
nessesary 

information, 
configures advanced 
settings. Message is 

interesting within the 
rules of conduct. 

   (1)      (2)     (3)      (4) 

        
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B.21 Organise/manage on-line communities 

Set up an on-line account in Google+ (or similar service) and ask your friends to join a new cooking community 
about wines. Create interest for your members. 

 

Can do with 
assistance 

 

Creates one 
community, needs 

help to engage 
members 

Creates community, 
creates at least one 
conversations about 

the topic 

Creates community, 
creates at least two 
conversations about 

the topic with 
interesting content 

that creates interest 

(e.g. asking opinions 
about a recipe that is 

posted) 

   (1)      (2)     (3)      (4) 

        

 

 

 

Score for Competence 2.1: Interacting through digital technologies 

_____ out of 20 points 

 

Score range PL Result 

5-7 1-Basic   

8-12 2-Basic   

13-17 3-Intermediate   

18-20 4-Intermediate   
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Competence 2.3: Engaging in citizenship through digital technologies 

 

B.22 Find information and services for engaging in citizenship. 

Find information or services on food safety policies and risks. 

 

Can do with 
assistance 

 

Uses a search engine 
to find relevant 

information 

Uses a search engine 
to find relevant 
information and 

services 

Uses a search engine 
to find relevant 

information and at 
least one e-service on 
the Web. Searches for 
apps in mobile device. 
Signs in newsletter or 

other information 
service 

   (1)      (2)    (3)     (4) 

        

 

 

B.23 Publish information relevant to citizenship issues 

Publish information on a specific topic of food safety policies and risks (e.g. your opinion on organic 
ingredients). 

 

Can do with 
assistance 

B 

Posts opinion on 
forum 

Posts comments in 
social media 

(e.g. Facebook, 
Twitter) 

Sends a complaint or 
other feedback to an 

eGovernement 
service 

 

   (1)      (2)    (3)     (4) 

        
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B.24 Register in e-services for citizenship 

Set up accounts to e-services about food safety policies. Fill-in forms needed for registration. 

 

Can do with 
assistance 

 

Sets-up account to 
social media 

Sets up accounts in at 
least one private 

service 

(e.g. NGO) 

Sets up accounts in at 
least one public and 

at least in one private 
service 

(e.g. National 
Association of Food 

and Safety) 

   (1)      (2)    (3)      (4) 

        

 

B.25 Use digital services to inform other people 

Inform other people about the food safety policies. 

 

Can do with 
assistance 

 

Sends emails to 
friends 

Posts messages to 
social media 

Starts a blog or a 
dedicated Social 
media account 

   (1)      (2)    (3)    (4) 

        

 

 

Score for Competence 2.3: Engaging in citizenship through digital technologies 

_____ out of 16 points 

 

Score range PL Result 

4-5 1-Basic   

6-9 2-Basic   

10-13 3-Intermediate   

14-16 4-Intermediate   
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Competence 3: Content creation 

 

3.1 Developing digital content 

 

B.26 Create pictures and upload it to Recipe Builder 

Take a picture of a recipe ingredient save and upload the file to the Recipe Builder. 

 

Can do with 
assistance 

 

Takes picture with 
tablet or mobile, 

needs help to save it 

Takes picture with 
tablet or mobile, 

saves it 

Takes picture with 
tablet or mobile, 

saves it and uploads it 
to the recipe builder 

   (1)      (2)    (3)      (4) 

        

 

B.27 Create video and upload it to the Recipe Builder 

Record a video for a recipe step and upload it to the recipe builder 

 

Can do with 
assistance 

 

Records video with 
tablet or mobile, 

needs help to save it 
and upload it 

Records video with 
tablet or mobile, 

saves it 

Records video with 
tablet or mobile, 

saves it and uploads it 
to the recipe builder 

   (1)      (2)    (3)      (4) 

        

 

B.28 Create audio and upload it to the Recipe Builder 

Record audio describing an ingredient and upload it to the recipe builder 

Can do with 
assistance 

 

Records audio with 
tablet or mobile, 

needs help to save it 
and upload it 

Records audio with 
tablet or mobile, 

saves it 

Records audio with 
tablet or mobile, 

saves it and uploads it 
to the recipe builder 

   (1)      (2)     (3)      (4) 

        
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B.29 Edit an image 

Open an image of a recipe ingredient you took earlier with your camera and delete areas that need not be in 
the picture 

 

Can do with 
assistance 

 

Selects the 
appropriate app and 

opens the image. 
Needs help to 

continue 

Opens the image, and 
selects an area. 

Opens the image, 
selects and cuts at 

least two areas. Saves 
file. 

   (1)      (2)    (3)     (4) 

        

 

B.30 Edit a video 

Open a video of a recipe step you recorded earlier with your camera and delete scenes that need not be in the 
video. 

 

Can do with 
assistance 

 

Selects the 
appropriate app and 

opens the video. 
Needs help to 

continue 

Opens the video, and 
selects a timeline. 

Opens the video, 
selects and cuts at 

least two timelines. 
Saves file. 

   (1)      (2)    (3)      (4) 

        

 

B.31 Edit audio 

Open an audio file of a description of an utensil you recorder earlier and delete parts that are too noisy. 

 

Can do with 
assistance 

 

Selects the 
appropriate app and 
opens the audio file. 

Needs help to 
continue 

Opens the audio file, 
and selects a timeline. 

Opens the audio file, 
selects and cuts at 

least two timelines. 
Saves file. 

    (1)      (2)    (3)      (4) 

        
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B.31 Combine basic media files to produce a multimedia presentation 

Combine media files in the recipe builder to produce a multimedia presentation. Use at least one video, one 
image and one audio file to describe a step of the recipe, the basic ingredients and the basic utensils used. 

 

Can do with 
assistance 

 

Creates recipe, 
uploads an image 

Creates a recipe, 
creates ingredients or 
utensils list (uploads 

images, audio) 

Creates a recipe, 
creates ingredients or 

utensils list, 
completes a step 
(uploads video) 

   (1)     (2)    (3)     (4) 

        

 

 

Score for Competence 3.1: Developing digital content:_____ out of 28 points 

 

Score range PL Result 

7-10 1-Basic   

11-17 2-Basic   

18-24 3-Intermediate   

25-28 4-Intermediate   
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APPENDIX III CERTIFICATE AWARD - LIST OF SKILLS 
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A-III-1.1: Browsing, searching and filtering data, information and digital 
content 

 

   

Competence Area 1: Information and data literacy 

Competence: 1.1: Browsing, searching and filtering data, information and digital content 

Proficiency Lvl: 1- Foundation 

Generic Skills award: With help can: 

• identify appropriate information sources 

• identify what a web browser is and identify the tasks it can be used for 

• identify keywords that describe the information I need  

• find data by performing simple keyword search on text search engines 

• identify the basic structure of web content (linked documents) 

• identify the basic principles of web navigation (browsing) 

• identify what a search strategy is and the need to have one 

LinguaCuisine-specific Skills 
award: 

With help can: 

• identify a search engine to use 

• identify a keyword that describes the type of the recipe  

• access a specific recipe site from a list of search results using 
hyperlinks 

• navigate through search results and go back and forth 

• search by subject using the type of the recipe 

Competence Area 1: Information and data literacy  

Competence: 1.1: Browsing, searching and filtering data, information and digital content 

Proficiency Lvl: 2- Foundation 

Generic Skills award: Independently can: 

• identify appropriate information sources 

• know what a web browser is and identify the tasks it can be used for 

• identify keywords that describe the information needed 

• Find data by performing simple keyword search on text search engines 

• understand the basic structure of web content (linked documents) 

• understand the basic principles of web navigation (browsing) 

• understand what a search strategy is and the need to have one 

LinguaCuisine-specific Skills 
award: 

Independently can: 

• identify appropriate keywords to search for recipe-related information 

• search for recipe-related information 
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Competence Area 1: Information and data literacy  

Competence: 1.1: Browsing, searching and filtering data, information and digital content 

Proficiency Lvl: 3- Intermediate 

Generic Skills award: Autonomously can: 

• use different search engines or specific portals 

• identify most keywords that describe the information I need 

• identify the basic vocabulary that can be used to describe browsing, 
searching and filtering information 

• access a web page directly  

• access a specific site from a list of search results 

• access a resource from a list within a repository 

• access a video 

• understand the role of keywords and the ways they can be combined to 
produce correct results  

• edit keywords to improve the search outcome 

LinguaCuisine-specific Skills 
award: 

Autonomously can: 

• name the search engines or recipe portals I routinely use  

• identify most keywords that describe the type of the recipe 

• directly access a recipe search engine or a recipe blog 

• access a specific recipe site from a list of search results using hyperlinks 

• access a specific recipe site from a list of search results using filters 

• access a video for a recipe I want to find by previewing 

• evaluate which keywords produce correct results 
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Competence Area 1: Information and data literacy  

Competence: 1.1: Browsing, searching and filtering data, information and digital content 

Proficiency Lvl: 4- Intermediate 

Generic Skills award: Autonomously can: 

• use different types of search engines 

• identify all keywords that describe the information needed 

• adjust search according to specific needs 

• use online social media tools to locate and view content  

• access and navigate through the resources in a collection 

• understand the properties (qualities) of a good search strategy 

LinguaCuisine-specific Skills 
award: 

Autonomously can: 

• name video search engines or recipe repositories when searching for 
recipes 

• identify all keywords that describe the type of the recipe 

• perform different searches to locate a recipe 

• locate forums about specific types of recipes 

• access a specific recipe video from a collection using the navigation 
panel 

• organize the keywords that produce quality results by evaluating the 
results of past searches 
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A-III-1.2: Evaluating data, information and digital content  

 

 

 

 

Competence Area 1: Information and data literacy  

Competence: 1.2: Evaluating data, information and digital content 

Proficiency Lvl: 2- Foundation 

Generic Skills award: Independently can: 

• find the information about a website's owner/provider 

• detect Internet domain names and how they can help to assess the 
reliability of a website 

LinguaCuisine-specific Skills 
award: 

Independently can: 

• distinguish which recipe resources are more reliable by judging the 
reputation of the editor or the web host/owner 

• distinguish which recipe resources are more reliable by looking at the date 
of the publishing of the information or how often this information is 
updated 

 

  

Competence Area 1: Information and data literacy  

Competence: 1.2: Evaluating data, information and digital content 

Proficiency Lvl: 1- Foundation 

Generic Skills award: With help can: 

• distinguish reputable and reliable information sources from others  
 

LinguaCuisine-specific 
Skills award: 

With help can: 

• distinguish which recipe resources are more reliable by judging the 
reputation of the editor or the web host/owner 

• distinguish which recipe resources are more reliable by using published 
lists of the most popular web sites 
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Competence Area 1: Information and data literacy  

Competence: 1.2: Evaluating data, information and digital content 

Proficiency Lvl: 3- Intermediate 

Generic Skills award: Autonomously can: 

• Evaluate information or content that I find online may, or may not be 
reliable, by looking at specific qualities of the content such as language, 
precision, appearance 

• Interpret results to improve search procedures 

• Discern the advertisement and promoted content among the results of 
an online search and on social network pages 

LinguaCuisine-specific Skills 
award: 

Autonomously can: 

• assess the reliability of a recipe site or a blog by checking if the 
ingredient list of recipes provided match the recipe instructions, if the 
language used is precise and serious  

• edit keywords to locate more reliable web sites for recipes  

• evaluate which adds concerning cooking web sites are worth looking at 

 

Competence Area 1: Information and data literacy  

Competence: 1.2: Evaluating data, information and digital content 

Proficiency Lvl: 4- Intermediate 

Generic Skills award: Autonomously can: 

• critically evaluate the credibility and reliability of non-web sources of 
data, information and content 

• understand the properties of good quality unstructured content 

• compare the outcome of different searches 

• use different information repositories and search strategies 

LinguaCuisine-specific Skills 
award: 

Autonomously can: 

• assess the reliability of a recipe Facebook account by looking at the 
number of users following the account and the type of posts and 
comments 

• compare the reliability of different recipe accounts on Facebook by 
comparing the number of followers and the quality and frequency of 
comments  

• combine results from searches on Facebook and Google on a specific 
recipe 
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A-III-1.3: Managing data, information and digital content g  

 

 

Competence Area 1: Information and data literacy  

Competence: 1.3: Managing data, information and digital content  

Proficiency Lvl: 2- Foundation 

Generic Skills award: Independently can: 

• identify appropriate information sources 

• know what a web browser is and identify the tasks it can be used for 

• identify keywords that describe the information needed 

• Find data by performing simple keyword search on text search engines 

• understand the basic structure of web content (linked documents) 

• understand the basic principles of web navigation (browsing) 

• understand what a search strategy is and the need to have one 

LinguaCuisine-specific Skills 
award: 

Independently can: 

• identify appropriate keywords to search for recipe-related information 

• search for recipe-related information 

 

Competence Area 1: Information and data literacy  

Competence: 1.3: Managing data, information and digital content  

Proficiency Lvl: 1- Foundation 

Generic Skills award: With help can: 

• identify the different digital content formats 

• identify the difference between online and offline storage 

• identify the basic content manipulation operations (open and save) 

• Understand how information is stored on different devices/services 

• Understand how information can be organized in a storage device so as 
to be easily retrievable 

 

LinguaCuisine-specific Skills 
award: 

With help can: 

• identify in which format to save recipe-related content (images, audio, 
video, text, web address) 

• identify how to open a recipe/image stored earlier in a storage device 
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Competence Area 1: Information and data literacy  

Competence: 1.3: Managing data, information and digital content  

Proficiency Lvl: 3- Intermediate 

Generic Skills award: Autonomously can: 

• open, copy and move files or folders inside a digital device  

• save files and folders on external hard disk, USB memory, memory card 

• use the browser to save browsing history 

• structure and classify information and content according to a standard 
classification scheme/method  

• organize folders to use them as file repositories  
 

LinguaCuisine-specific Skills 
award: 

Autonomously can: 

• organize recipe files of different formats to appropriate folders 

 

 

Competence Area 1: Information and data literacy  

Competence: 1.3: Managing data, information and digital content 

Proficiency Lvl: 4- Intermediate 

Generic Skills award: Autonomously can: 

• understand basic backup policies 

• save files and folders on a cloud service 

• organise bookmarks in a browser 

• uses various classification schemes to store and manage resources and 
information 

LinguaCuisine-specific Skills 
award: 

Autonomously can: 

• save images of a recipe to Recipe Builder 

• create a backup of own files 

• organise recipe bookmarks to categories according to the type of food 

• organize recipes of different types and containing different media to 
appropriate folders and subfolders 

• tag content in the Recipe Builder 
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A-III-2.1:  Interacting through digital technologies  

 

 

 

 

 

 

 

Competence Area 2: Communication and collaboration  

Competence: 2.1:  Interacting through digital technologies 

Proficiency Lvl: 1- Foundation 

Generic Skills award: With help can: 

• distinguish between synchronous an asynchronous communication 
media 

• identify how messages and emails are stored and displayed 

• identify the services offered by social media tools  

• send an email, write a blog post 

• use a chat or a discussion forum to communicate with others 

LinguaCuisine-specific Skills 
award: 

With help can: 

• select applications suitable for communicating cooking information 

• select the appropriate on-line community for communicating with 
others with the same interests in cooking 

Competence Area 2: Communication and collaboration 

Competence: 2.1:  Interacting through digital technologies 

Proficiency Lvl: 2- Foundation 

Generic Skills award: Independently can: 

• distinguish between synchronous an asynchronous communication 
media 

• identify how messages and emails are stored and displayed 

• identify the services offered by social media tools  

• send an email, write a blog post 

• use a chat or a discussion forum to communicate with others 

LinguaCuisine-specific Skills 
award: 

Independently can: 

• select applications suitable for communicating cooking information 

• select the appropriate on-line community for communicating with 
others with the same interests in cooking 
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Competence Area 2: Communication and collaboration 

Competence: 2.1:  Interacting through digital technologies 

Proficiency Lvl: 3- Intermediate 

Generic Skills award: Autonomously can: 

• start a new online community 

• start a new online discussion 

• start a new online blog 

• organise and moderate on-line events 

• understand and use a code of contact 
 

LinguaCuisine-specific Skills 
award: 

Autonomously can: 

• start a blog about cooking 

• organise a Skype meeting with other peers that have similar interests in 
cooking 

• create a personal profile on Facebook 

 

Competence Area 2: Communication and collaboration 

Competence: 2.1:  Interacting through digital technologies 

Proficiency Lvl: 4- Intermediate 

Generic Skills award: Autonomously can: 

• select appropriate application from a list of options depending on 
particular needs 

• select appropriate functions from a list of options of an application 
depending on particular needs 

• configure application 

• understand the importance of the virtual intentity and manage its 
properties 

• moderate community content in social media 

• select and use different tools for communicating depending on the 
purpose of the communication 

LinguaCuisine-specific Skills 
award: 

Autonomously can: 

• configure Skype to use video and chat for showcasing in a live audience 
how to execute a difficult recipe 

• modify personal profile in various on-line applications depending on the 
situation 

• configure the properties of discussion group in a forum for cooking 
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A-II I -2.3:  Engaging in cit izenship through digital  technologies  

 

 

 

 

Competence Area 2: Communication and collaboration 

Competence: 2.3:  Engaging in citizenship through digital technologies 

Proficiency Lvl: 2- Foundation 

Generic Skills award: Independently can: 

• find and access the websites National and European Food Safety 
organizations, boards and NGOs 

• access a number of relevant networks and communities for different 
purposes  

• find relevant communities, networks, and social media that correspond 
to specific interests and needs 

• set up online accounts for private/public services 

• set up online accounts for private/public services 

LinguaCuisine-specific Skills 
award: 

Independently can: 

• follow Food and Safety Association on Twitter 

  

Competence Area 2: Communication and collaboration  

Competence: 2.3:  Engaging in citizenship through digital technologies 

Proficiency Lvl: 1- Foundation 

Generic Skills award: With help can: 

• find and access the websites National and European Food Safety 
organizations, boards and NGOs 

• access a number of relevant networks and communities for different 
purposes  

• find relevant communities, networks, and social media that correspond 
to specific interests and needs 

LinguaCuisine-specific Skills 
award: 

With help can: 

• find and access the website of the National Food Administration or of 
the European Food Safety Authority or of he Committee on the 
Environment, Public Health and Food Safety 

• find and access the Facebook account of  the Organic Consumer 
Association 
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Competence Area 2: Communication and collaboration 

Competence: 2.3:  Engaging in citizenship through digital technologies 

Proficiency Lvl: 3- Intermediate 

Generic Skills award: Autonomously can: 

• select an on-line web based service that empowers citizenship 

• fill-in online forms with personal data 

• post an opinion for a review site 

• send a complaint or other feedback to a service provider 

LinguaCuisine-specific Skills 
award: 

Autonomously can: 

• select and subscribe to the eNews services  

• sign-in to request to be a member in committees and receive 
newsletters 

• post complaints 

 

 

Competence Area 2: Communication and collaboration 

Competence: 2.3:  Engaging in citizenship through digital technologies 

Proficiency Lvl: 4- Intermediate 

Generic Skills award: Autonomously can: 

• select an on-line social medium that empowers citizenship 

• inform other people about on-line campaigns and events 

LinguaCuisine-specific Skills 
award: 

Autonomously can: 

• select a Twitter campaign that sought to empower the citizens of your 
city to participate in an event for the ban of synthetic crops 

• email to friends the details of a Facebook campaign for using healthy 
food 
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A-II I -3.1:  Developing digital  content  

 

 

 

Competence Area 3: Digital Content Creation 

Competence: 3.1:  Developing digital content 

Proficiency Lvl: 2- Foundation 

Generic Skills award: Independently can: 

• identify basic categories of software content management applications 

• identify basic editing functions of text, audio, video and image (copy, 
cut, paste, clear, select, find) 

LinguaCuisine-specific Skills 
award: 

Independently can: 

• identify what type of applications are needed to create content for 
digital recipe scenarios 

• identify how to upload content onto the LinguaCuisine Recipe Builder 

  

Competence Area 3: Digital Content Creation  

Competence: 3.1:  Developing digital content 

Proficiency Lvl: 1- Foundation 

Generic Skills award: With help can: 

• identify basic categories of software content management applications 

• identify basic editing functions of text, audio, video and image (copy, 
cut, paste, clear, select, find) 

LinguaCuisine-specific Skills 
award: 

With help can: 

• identify what type of applications are needed to create content for 
digital recipe scenarios 

• identify how to upload content onto the LinguaCuisine Recipe Builder 
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Competence Area 3: Digital Content Creation 

Competence: 3.1:  Developing digital content 

Proficiency Lvl: 3- Intermediate 

Generic Skills award: Autonomously can: 

• apply basic operations (new file, type, save) for basic content (text, 
image, audio, video) creation 

• create basic content (text, image, audio, video) in different formats  

• Edit (copy, cut, paste, clear, select) basic content (text, image, audio, 
video) files 

• Upload content onto on-line platforms and repositories 

LinguaCuisine-specific Skills 
award: 

Autonomously can: 

• Record a video for α recipe and save it using the MP4 format 

• Record audio for α recipe and save it as an MP3 file 

• Take a picture during the execution of α recipe and save it as a JPG file 

• Create a text that describes the exact steps for executing a recipe and 
save it as a Word file 

• Upload a video that was created during the execution of your recipe 
onto the recipe builder  

• Upload a video onto the LinguaCuisine platform 

• Use the default printer to print a Word file that contains text describing 
a recipe 
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Competence Area 3: Digital Content Creation 

Competence: 3.1:  Developing digital content 

Proficiency Lvl: 4- Intermediate 

Generic Skills award: Autonomously can: 

• configure the app that creates the content so as to achieve the best 
quality in relation to the setting 

• choose the right format (to save own files) for the indented purpose 

• manipulate size of output file during content creation by configuring the 
content attributes 

• upload content onto online platforms depending on its format and size 

• use apps for content creation that suits a purpose by identifying the 
capabilities and services offered by them 

• use devices that enchase own creation in other means 

LinguaCuisine-specific Skills 
award: 

Autonomously can: 

• advice another person what format to choose to save his video 
depending on its duration 

• deal with problems concerning the configuration of the save setting of 
an image I created  

• deal with problems concerning which cloud storage service to use to 
upload all the pictures that were created during the recipe course over a 
3G network 

• deal with problems concerning noise in recorded audio by using an app 
that automatically removes background sounds   

• find and select a suitable printer in the network to print a Word file that 
contains text describing a recipe 

• I can use Powerpoint to create an automated presentation of my digital 
story 

• combine basic media files to produce a multimedia presentation using 
the Recipe Builder 

 


